Boris

Final Effects Complete

Native Filters and Transitions
Boris Final Effects Complete

The material contained herein is protected by copyrights. Permission to use materials may be granted upon written request and proper credit.

U.S. GOVERNMENT END USERS. The Boris FX program and related documentation is a commercial item, as that term is defined in 48 C.F.R. 12.101 (Oct. 1995), consisting of commercial computer software and commercial computer software documentation, as such terms are used in 48 C.F.R. 12.212 (Sept. 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4 (June 1995), all U.S. Government End Users acquire the Boris FX program and related documentation with only those rights set forth in the applicable license agreement. The manufacturer is Boris FX, Inc., 381 Congress St., Boston, MA 02210.

The software described in this document is furnished under a license agreement. The software may not be decompiled, cross-compiled, disassembled, reverse engineered or re-engineered, and may be used and copied only in accordance with the terms of the license agreement. Portions of the system described in this document are protected under the U.S. patent laws, and may be covered by patent numbers 6,243,143. Allowed patents and filed U.S. and foreign patent pending applications include: MIPS Operation System software, Digital ProcAmp (Spec. section 2.1), Media Project Management (Spec. section 2.6.3), Batch acquisition and reacquisition (Spec. section 2.6.3).

Contact information
Boris FX, Inc.
381 Congress Street
Boston, MA 02210
Phone: (617) 451-9900
Fax: (617) 451-9916
E-mail: info@borisfx.com
http://www.borisfx.com

For information on site licenses
Please call (617) 451-9900 or e-mail sitelicense@borisfx.com

For technical support
Visit the Boris FX Technical Forum at http://www.borisfx.com/support. You can also contact technical support by calling (617) 451-9900 or e-mailing techsupport@borisfx.com.

The information in this guide is believed to be accurate and reliable. However, Boris FX, Inc. assumes no responsibility for its use; nor for any infringements of patents or other rights of third parties which may result from its use. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form, by any means, electronic, mechanical, by photocopying recording or otherwise without the prior written permission of Boris FX, Inc.

Final Effects Complete and PixelChooser are trademarks of Boris FX. Boris FX, Inc. recognizes the following third-party trademarks or registered trademarks: Adobe After Effects and Apple Final Cut Pro. All other product, brand, or trade names used in this publication are the trademarks or registered trademarks of their respective trademark owners.


Copyright © 2005 by Boris FX, Inc. All rights reserved. Printed in the U. S. A.

Updated September 2005.
About this Guide

The Boris Final Effects Complete Guide provides information on the basic features and functions of Final Effects Complete. Once you install your software, refer to this guide for an overview of the effects.

If the information in this guide differs from that in the Release Notes, follow the information given in the Release Notes.

Understanding Plug-ins

Boris Final Effects Complete is a plug-in. Plug-ins are software products which are added to your NLE (non-linear editor) to enhance its functionality. Plug-in files must reside in a specific folder on your computer so that the host application can find them. If a plug-in is misplaced or moved, the host application may lose track of it. When your NLE starts, it examines the plug-in folder for the available plug-ins. All recognized plug-ins become available to the user.

Plug-ins become an integral part of the host program, sharing all of its resources including memory. Plug-ins are not separate applications; they do not have to run in the background and do not require additional memory.

Included in this Guide

This guide is designed to help you understand the many options offered by Boris Final Effects Complete so that you use this complex program to its fullest potential. The Boris Final Effects Complete User Guide is organized as follows:

• Chapter 1: Getting Started introduces the effects and their compatibility with the various NLEs. It also provides procedures to access the effects in the respective plug-in menus.
• Chapter 2: Blur & Sharpen Effects describes the controls for the FE Blur & Sharpen effects.
• Chapter 3: Color Correction Effects describes the controls for the FE Color Correction effects.
• Chapter 4: Distort Effects describes the controls for the FE Distort effects.
• Chapter 5: Edges Effects describes the controls for the FE Edges effects.
• Chapter 6: Image Effects describes the controls for the FE Image effects.
• Chapter 7: Light Effects describes the controls for the FE Light effects.
• Chapter 8: Particle Effects describes the controls for the FE Particle effects.
• Chapter 9: Perspective & Time Effects describes the controls for the FE Perspective and Time effects.
• Chapter 10: Stylize Effects describes the controls for the FE Stylize effects.
• Chapter 11: Creating Transitions Effects describes the controls for the FE Transitions.

Who Should Use this Guide
This guide is for the user who wants an overview of application features and functionality. This guide assumes that you understand your computer’s operating system at a fundamental level and are familiar with basic computer functions such as clicking, dragging, scrolling, and choosing commands from menus. You should also know how to create, open, and save documents and folders. Consult the documentation provided with your computer if you are not familiar with these terms and functions.

What You Need to Know
You should have a knowledge of online digital content editing and/or compositing. This guide assumes that you have installed the nonlinear editing software on your system and are proficient enough to perform basic editing techniques. You must also know how to apply effects to the timeline, edit effects, and render effects to use Boris Final Effects Complete. If you are unfamiliar with these operations, consult the documentation provided with your NLE.

Conventions and Symbols
Several formatting conventions and symbols are used throughout this guide to convey important information.
• The first time a parameter name or other important term is mentioned, the name appears in bold print. Menu choices that appear in the control panels are written in italics. For example, “Set Make Matte From to Luminance” means to choose the “Luminance” option in the “Make Matte From” menu.
• The chevron symbol (>) indicates choosing a command from a menu. For example, “Choose File > Save” means to choose the Save command from the File menu.
The following icons are used to denote sections of special interest:

- Indicates warnings about procedures that might produce unwanted effects, are very memory-intensive, or cannot be easily undone.
- Accompanies useful notes about a parameter, filter, or procedure. These notes can help you better understand how to use Boris Continuum Complete.
- Denotes a reference to another part of the manual in the text. Check the indicated sections for further information.
- Accompanies creative ideas and techniques for using Boris Continuum Complete to produce specific effects.

**Registering Your Product**

To ensure that we have an accurate record of your purchase, please register your software at [www.borisfx.com/register/](http://www.borisfx.com/register/).

**Contacting Technical Support**

If you encounter questions or difficulties that are not covered in this manual visit the Boris FX Technical Forum at [http://www.borisfx.com/support](http://www.borisfx.com/support), and look for the link for your host application and operating system. You can also contact Boris FX Technical Support by calling (617) 451-9900 or e-mailing techsupport@borisfx.com.
Chapter 1
Getting Started

Introduction ................................................................. 8
Supported Filters .......................................................... 8
Applying Final Effects Complete in Adobe After Effects .......... 10
  Applying FEC Effects as Filters ........................................ 10
  Applying FEC Effects as Transitions ................................. 10
  Working with Parameter Groups ...................................... 11
  Working with Layer Menus and Precomposing ..................... 11
  Hiding a Filter .......................................................... 12
  Resetting a Filter ...................................................... 12
  Understanding Contextual Controls in After Effects ............... 12
Applying Final Effects Complete in Apple Final Cut Pro ............ 13
  Applying FEC Effects as Filters ........................................ 13
  Applying FEC Effects as Transitions ................................. 13
  Working with Parameter Groups ...................................... 19
  Hiding a Filter .......................................................... 20
  Resetting a Filter ...................................................... 20
  Understanding Contextual Controls in Final Cut Pro ............... 20
Applying Final Effects Complete in Discreet Combustion .......... 21
  Applying FEC Effects as Filters ........................................ 21
  Applying FEC Effects as Transitions ................................. 21
  Working with Parameter Groups ...................................... 23
  Understanding Contextual Controls in Combustion ................ 26
  Hiding a Filter .......................................................... 26
  Resetting a Filter ...................................................... 26
Applying Final Effects Complete in Boris Red, Graffiti or FX ..... 27
**Introduction**

This chapter describes the Boris Final Effects Complete filters that are available as native plug-in effects for use with Adobe After Effects for Macintosh OS X, Windows 2000 and Windows XP. In addition, Final Effects Complete for Mac OS X is also compatible with Apple Final Cut Pro, Boris Red, Boris Graffiti, Boris FX and Discreet Combustion.

**Supported Filters**

Depending on your plug-in, you can access more than 100 effects. To view examples of each effect, please visit the Boris website at [www.borisfx.com/FEC/gallery/](http://www.borisfx.com/FEC/gallery/).

The following table describes the filters that are included with Final Effects Complete. Not all filters are compatible with all host applications.

**Final Effects Complete Filters**

<table>
<thead>
<tr>
<th>Blur &amp; Sharpen Effects</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Blur</td>
<td>Channel</td>
<td>Chroma/Luma Blur</td>
<td>Directional Blur</td>
</tr>
<tr>
<td>Vector Blur</td>
<td>Sharpen</td>
<td>Soften</td>
<td>Spin Blur</td>
</tr>
<tr>
<td>Spiral Blur</td>
<td>Unsharpen Mask</td>
<td>Zoom Blur</td>
<td></td>
</tr>
</tbody>
</table>

**Color Correction Effects**

<table>
<thead>
<tr>
<th>Brightness &amp; Contrast</th>
<th>Color Balance (HLS)</th>
<th>Color Balance (RGB)</th>
<th>Color Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Threshold (RGB)</td>
<td>Replace Color</td>
<td>Gamma/Pedestal/Gain</td>
</tr>
<tr>
<td>Invert</td>
<td>Levels</td>
<td>Tint</td>
<td></td>
</tr>
</tbody>
</table>

**Distort Effects**

<table>
<thead>
<tr>
<th>EZ LazyWaves</th>
<th>Bulge</th>
<th>EZ Ripples</th>
<th>Bend It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bender</td>
<td>Flo Motion</td>
<td>Griddler</td>
<td>Lens</td>
</tr>
<tr>
<td>Power Pin</td>
<td>Ripple Pulse</td>
<td>Slant</td>
<td>Slant Matte</td>
</tr>
<tr>
<td>Smear</td>
<td>Spherize</td>
<td>Split</td>
<td>Split 2</td>
</tr>
<tr>
<td>Tiler</td>
<td>Twirl</td>
<td>Waterwaves</td>
<td></td>
</tr>
</tbody>
</table>

**Edges Effects**

<table>
<thead>
<tr>
<th>Burn Edges</th>
<th>Gradient Blur</th>
<th>Power Ramp</th>
<th>Sparkle Edges</th>
</tr>
</thead>
</table>
### Final Effects Complete Filters

<table>
<thead>
<tr>
<th>Blur &amp; Sharpen Effects</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Spot Blur</td>
<td>Spot Feather</td>
<td>Spot Frame</td>
</tr>
<tr>
<td>Spot Turbulence</td>
<td>Wiggle Edges</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image Effects</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Noise</td>
<td>Alpha Map</td>
<td>Composite</td>
</tr>
<tr>
<td>Median</td>
<td>Min/Max</td>
<td>Noise</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Light Effects</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Light Burst 2.5</td>
<td>Light Rays</td>
<td>Light Sweep</td>
</tr>
<tr>
<td>LightTornado</td>
<td>LightWhirl</td>
<td>Spotlight</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Particle Effects</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ball Action</td>
<td>Bubbles</td>
<td>Drizzle</td>
</tr>
<tr>
<td>Mr. Mercury</td>
<td>Particle System II</td>
<td>Particle World</td>
</tr>
<tr>
<td>Rain</td>
<td>Snow</td>
<td>Star Burst</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Perspective Effects</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced 3D</td>
<td>Page Turn</td>
<td>Cylinder</td>
</tr>
<tr>
<td>Simple Shadow</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stylize Effects</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Relief</td>
<td>Emboss</td>
<td>Blobbylize</td>
</tr>
<tr>
<td>Glass</td>
<td>Glue Gun</td>
<td>Kaleida</td>
</tr>
<tr>
<td>RepeTile</td>
<td>Scatterize</td>
<td>Fractal</td>
</tr>
<tr>
<td>Lenstar</td>
<td>VideoFragment</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time Effects</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Blend</td>
<td>Time Blend FX</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transitions Effects</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Glass Wipe</td>
<td>Grid Wipe</td>
<td>Image Wipe</td>
</tr>
<tr>
<td>LightWipe</td>
<td>Radial ScaleWipe</td>
<td>ScaleWipe</td>
</tr>
</tbody>
</table>
Applying Final Effects Complete in Adobe After Effects

This section provides information on using Boris Final Effects Complete in the After Effects user interface.

Applying FEC Effects as Filters

When the Boris Final Effects Complete filters are installed in the After Effect’s plug-ins folder, they automatically appear in the Effect menu with the other After Effects filters. The filters are arranged into the following eleven categories: Blur & Sharpen, Color Corrections, Distort, Edges, Image, Light, Particle, Perspective, Stylize, Time, and Transitions filters. To apply a Boris filter, simply choose the filter from the appropriate FEC filter category in the Effect menu and apply it as you would any After Effects filter.

Applying FEC Effects as Transitions

All of the FEC filters can be used as transitions in After Effects. Effects apply as static transitions and you need to manually keyframe the transition from the unfiltered outgoing shot to the unfiltered incoming shot. There are several ways to add transition effects in After Effects, including the following. Consult the After Effects documentation for more information on adding and keyframing transitions.

1. Stack the clips you want to use in the transition above each other on the Video tracks in the timeline. Overlap them enough to create a transition of the desired length. Place the outgoing clip on the video layer above the incoming clip.

2. Place the current-time indicator where you want the transition to start. Select the outgoing clip and choose Edit > Split Layer.

   A new outgoing clip is created, spanning the duration of the transition.

3. Select the new clip and add the FEC effect you want to use as a transition.

4. Manually keyframe the transition for this outgoing clip using the parameters in the FEC filter. You may need to adjust the After Effects Opacity or Position controls.

5. Apply the same effect to the incoming clip. Manually keyframe the transition using the parameters in the effect as well as After Effects Opacity or Position controls.

6. Render FEC Effects the same way you would any After Effects effect.
Working with Parameter Groups

Each Final Effects Complete filter has parameter controls which are categorized into groups. Groups of parameters contain a disclosure triangle to the left of the text header. The following illustration includes multiple parameter groups. The Direction group has been expanded. Clicking the disclosure triangle to the left of a text header expands the parameter group, revealing its contents. Click the triangle a second time to close the group.

![Disclosure Triangle](image)

Parameters

Working with Layer Menus and Precomposing

Many filters include Layer menus which enable you to use information from other layers to control some aspect of the filter applied to the source layer. The Layer menu includes choices corresponding to each layer in the composition, in addition to a None setting. When None is chosen, the menu has no affect on the filter.

It is important to note that the filter uses the chosen layer’s source media without any effects and/or geometric transformations that were applied to the layer in the composition. If you want to transform the chosen layer and have the transformations affect the source layer, you need to complete the following steps to precompose:

1. Place the source media in a second composition and apply the desired effects and/or transformations.
2. Drag the second composition into the original composition.
3. If you already applied effects and geometrics to a layer, you can use the Precompose command (in the Layer menu) to move the layer and its effects into a new composition.
4. Choose the composition from the Layer menu.
Working with Point Controls
Many Boris Final Effects Complete filters use point controls to specify locations along the X and Y axis in the source image. If the effect is selected in the Effect Controls window, the Comp window includes a position point icon for each point control parameter. There are several different ways to enter and edit point control values:

- Click the cross-hair and click the mouse at the desired location in the Comp window.
- Click the cross-hair, adjust the location with the arrow keys, and press Return or Enter.
- Click the numerical values and enter new values in the dialog box.
- Select the appropriate effect in the Effect Controls window, and drag the position point corresponding to the point control that you want to adjust.

Working with Color Controls
Color controls are used to choose a color for some attribute of a filter or object, such as a light source, border, or text face. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen.

Hiding a Filter
In the Effect Controls or Timeline window, select the layer, and then click the Effect option to the left of the effect name.

Resetting a Filter
To reset a filter, click Reset at the top of the filter controls in the Effects Controls window.

Understanding Contextual Controls in After Effects
Unlike the other host applications, the After Effects architecture supports contextual controls. This means that parameters that do not apply display as “Unused” in the Effects Controls window, and are dimmed.
Applying Final Effects Complete in Apple Final Cut Pro

This section provides information on using Boris Final Effects Complete within the Final Cut Pro user interface.

Applying FEC Effects as Filters

The Boris Final Effects Complete filters are divided into the following eleven categories: Blur & Sharpen, Color Corrections, Distort, Edges, Image, Light, Particle, Perspective, Stylize, Time, and Transitions filters. The filters appear in the Video Filters submenu in the Effects menu.

1. Select the clip in the timeline to which you want to apply an effect and choose Effects > Video Filters > FEC Filter Category > FEC Filter. Alternatively, drag the chosen filter from the Video Effects folder in the Effect tab in the Browser to a clip in the timeline. The effect is applied to the selected clip.

2. Double-click the clip with the applied FEC filter to display and edit the filter parameters in the Viewer’s Filter tab.

3. Render FEC effects the way you would any other effect in FCP.

Applying FEC Effects as Transitions

FEC filters can also be used as transitions. The effects apply as static transitions and you need to manually keyframe the transition from the unfiltered outgoing shot to the unfiltered incoming shot.

FCP 4.x does not support the YUV color space for plug-ins and transitions render in RGB. This may cause visible color shifts when you create transitions in a YUV project. To correct this problem, see “Rendering Final Cut Pro Effects in RGB” on page 18. When you apply FEC effects as filters, color shifts are not an issue.

FEC provides two methods to use effects as transitions. The first method is to apply an FCP Cross Dissolve to the transition between the two clips, specify a range encompassing the cross dissolve, and apply an FEC filter to the range. The second method is to overlap two clips and apply an FEC filter to the top layer or both layers. Each method has its own advantages.

The Cross Dissolve method allows you to use any FEC filter as a transition and offers the convenience of an FCP transition. For example, trimming and duration changes are easily made and you only have to render a single effect. For details on using this method, see “Creating FEC Transitions Using the Cross Dissolve Method” on page 15.
However, to create a wider range of transition effects, you can use the second method—overlapping two clips and apply a filter to each layer. This method provides greater control over effect parameters. For details on using this method, see “Creating FEC Transitions by Overlapping Clips on Separate Video Layers” on page 17.

The following examples illustrate the difference between applying an effect as a transition using the Cross Dissolve method, and transitioning between two filters.

In the first example, FEC Water Waves was applied to a transition using the Cross Dissolve method. Notice that only the outgoing Drivers clip ripples; the incoming Racers clip simply dissolves in.

In the following example, the FEC Water Waves was applied using the second method, as a filter on two clips. Notice that both the Drivers and Racers clips ripple as they transition.
Creating FEC Transitions Using the Cross Dissolve Method

With the first method you apply an FCP Cross Dissolve to the transition between the two clips, specify a range encompassing the Cross Dissolve, and apply an FEC filter to the range.

1. Create a Final Cut Pro Cross Dissolve transition by dragging a Cross Dissolve transition from the Effects tab in the Browser between two adjacent clips. Alternatively, you can select the cut between the two clips where you want to place a transition and choose Effects > Video Transitions > Dissolve > Cross Dissolve.

   Using this method, the Cross Dissolve creates the actual transition by animating the Opacity. The FEC filter further manipulates the images during the transition.

2. Select the Range Selection tool from the Tool bar. Drag the mouse on the clips to highlight a range in the Timeline starting slightly before the transition start on the outgoing clip and extending slightly after the transition end on the incoming clip.

   When you finish, your timeline should appear similar to the following example.
3. Click to activate the Selection Tool.

4. In the Effects tab in the Browser, click the disclosure triangle to expand the Video Filters folder. Choose an FEC Category and select a filter in it to apply. Alternatively, select the transition and choose Effects > Video Filters > FEC Filter Category > FEC Filter. This example uses FEC Water Waves.

5. Drag the FEC Water Waves filter to the selected range in the Timeline. If your playhead is in the selected range, the filter effect appears in the Canvas window.

Several FEC filters such as the Wipe Transitions automatically animate. The other transition effects apply as static transitions that you need to manually keyframe during the cross dissolve.

6. Double-click the outgoing clip to open it in the Viewer. Click the Filters tab. The FEC filter controls appear. The range selected in the Timeline is represented in the Keyframe Graph area by a light gray bar bounded by two black lines. Only the area where you applied the filter is active.

7. Make sure the Playhead is at the beginning of the effect. Then click the Add Keyframe button for the Number of Waves and Amplitude parameters and set their values to 1 and 0 respectively. This sets the parameters so that the clip is unaffected by the effect.

8. Move the Playhead to the last frame of the effect. Create a keyframe at the last frame in the effect and increase Number of Waves and Amplitude to 5 and 100 respectively.

9. In the timeline, move the Playhead over the incoming clip to preview the effect. Double-click the incoming clip to load it into the Viewer.
10. Click the Filters tab. Add a keyframe at the beginning of the effect. Set **Number of Waves** and **Amplitude** to 5 and 100 respectively so that the effect starts with the incoming clip rippled. At this point you do not see the incoming clip in the Viewer because at the start of the effect the incoming clip is layered beneath the outgoing clip.

11. Move to the last frame of the effect and set the **Number of Waves** and **Amplitude** parameters to 1 and 0 respectively so that the image ends unrippled.

12. Render the FEC transition effect.

**Creating FEC Transitions by Overlapping Clips on Separate Video Layers**

The second method to create transitions is to overlap two clips and apply an FEC filter effect to each layer. This method provides greater control over effect parameters since you can animate the incoming and outgoing shots separately.

1. Place the outgoing shot on V2 and the incoming shot on V1. Overlap the clips for the duration of your transition.

   - The outgoing shot must be on a track higher in the timeline to properly reveal the incoming shot.

2. Use the **Razor Blade tool** to create razor edits around the section that you want to transition. In the following example, a one second section is used as a transition between the Racers and Drivers clips.

3. When you are done razoring the clips, click to activate the **Selection Tool**.

4. Apply the appropriate FEC effect to the overlapping section on the top (V2) track and double-click the effect to load it into the Viewer. In this example, an FEC Water Waves filter is added.

5. Click the Filters tab in the Viewer window to display the filter controls. The light gray bar bounded by two black lines indicates the active area for the filter you applied.

   - In this example, you want the Drivers clip to start unrippled, then gradually ripple as it dissolves out.

6. Make sure the Playhead is at the beginning of the effect. Then click the **Add Keyframe button** for the **Number of Waves** and **Amplitude** parameters and set their values to 1 and 0 respectively. This sets the parameters so that the clip is unaffected, which prevents the effect from jumping in at the Razored Edit.
7. Create a keyframe at the last frame in the effect and increase **Number of Waves** and **Amplitude** to 5 and 100 respectively.

8. Click the Motion tab in the Viewer to display the Basic Motion controls and move the Playhead to the middle of the effect. Then click the **Add Keyframe button** for the **Opacity** parameter and set its value to 100.

9. Move the Playhead to the last frame in the effect. Then click the **Add Keyframe button** for the **Opacity** parameter and set its value to 0. The effect now animates from fully opaque at the middle keyframe to fully transparent at the last keyframe.

10. Apply the same FEC effect to the bottom V1 track. Double-click the effect to load it into the Viewer.

11. In the Motion tab, create a keyframe in the middle of the effect and set its **Opacity** to 50.

12. Create a keyframe at the end of the effect and set its **Opacity** to 100.

13. In the Filters tab, create keyframes at the first frame of the effect for **Number of Waves** and **Amplitude**. Set values of 5 and 100 respectively.

14. Create keyframes at the last frame. Set the two parameters to 1 and 0 respectively so that no effect is visible. This prevents the effect from jumping at the Razored Edit.

15. Render the FEC transition effect.

**Rendering Final Cut Pro Effects in RGB**

FCP does not support the YUV color space for plug-ins and transitions render in RGB. This may cause visible color shifts when you create transitions in a YUV project. To correct this, complete the following steps. When you apply FEC as a filter, color shifts are not an issue.

1. Choose **Settings** from the **Sequence menu**.
2. In the Sequence Settings window, click the Video Processing tab.
3. Click to enable the **Always Render in RGB checkbox**.
4. Click **OK** to save your changes.
Working with Parameter Groups

Each Final Effects Complete filter has parameter controls which appear in the Filters tab.

Working with Layer Controls

Some filters include layer controls which let you use information from other media in your project to control some aspect of the filter applied to the source media.

To use a layer control, drag the desired clip or sequence from the Browser window to the Layer control. A thumbnail of the media displays in the layer control. If you do not drag a media file or sequence into the Layer control, the source media is used.

Clearing Layer Controls

To clear media assigned to a layer control, Control-click the layer control. A contextual menu displays. Choose Clear to delete the media from the layer control. Choose Self to assign the source media to the layer.

Working with Point Controls

Many Boris Final Effects Complete filters use point controls to specify locations along the X and Y axis in the source image.

You can enter and edit point control values in two ways:

- Click the cross-hair and click the mouse at the desired location in the Canvas window.
- Click the numerical values and enter new values in the dialog box.
Working with Custom Scrubber Controls

Some filters include custom scrubber controls to specify locations along the X, Y, and Z axis in the source image.

Press the + icon and drag the mouse up or down to adjust the Y axis or left and right to adjust the X axis. You can also click the About box and enter point control values in the dialog box that appears. Clicking the Z icon allows you to adjust the Z axis.

Working with Color Controls

Color controls are used to choose a color for some attribute of a filter or object, such as a light source, border, or text face.

Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen.

You can also use the Hue, Saturation, and Brightness sliders to change the value in the corresponding color channel, or input Hue, Saturation, and Brightness value directly into the numerical fields.

Hiding a Filter

You can hide a filter to view the effect without the filter or to speed previews. Click the Filter Visibility checkbox. When visibility is off, the filter is not displayed in the rendered output.

Resetting a Filter

To reset an FEC filter to the default values, reapply the filter from the Video Filters menu.

Understanding Contextual Controls in Final Cut Pro

The Final Cut Pro architecture does not support contextual controls, so parameters that do not apply are not dimmed in the Viewer. This means that a parameter in the Viewer may not apply unless other parameters are met.

Because many filters use contextual controls, some parameters may not appear to work. Consult the documentation for individual filters to determine whether a parameter is contextually dependent on another parameter.
Applying Final Effects Complete in Discreet Combustion

This section provides information on using Boris Final Effects Complete within the Combustion user interface.

Applying FEC Effects as Filters

The Boris Final Effects Complete filters are divided into the following eleven categories: Blur & Sharpen, Color Corrections, Distort, Edges, Image, Light, Particle, Perspective, Stylize, Time, and Transitions filters. The filters appear in the Operators tab.

1. Select the clip to which you want to apply an effect and click the Operators tab.
2. Choose an FEC category from the menu, then click a filter within the category. The filter displays in the workspace beneath the selected clip.
3. Click the filter in the workspace and click the Filter's tab or press F8 to display and edit the filter parameters. FEC filters contain extensive parameters that display over several pages.

Applying FEC Effects as Transitions

All Boris filters can be used as transitions in Combustion. However, you need to keyframe the transitions manually for most effects. To create transitions you overlap two clips and apply an FEC filter effect to each layer. This provides greater control over effect parameters since you can animate the incoming and outgoing shots separately.

1. Place the clips you want to use on separate layers and overlap them for the desired duration.
2. Keyframe the **Layer Opacity** control in the Composite Controls tab so that the outgoing clip fades out. You can also fade the incoming clip in if you want.

You may not need to do this for filters that generate their own alpha channels, for example a Page Turn or Particle World effect.

3. Select the clips in the Workspace and choose **Object > Nesting** to create a precomposition.

   A new Composite is created with the original two clips nested inside.

4. Apply the FEC Filter to the precomposition.

5. Click the FEC Filter’s tab in the dashboard and manually keyframe the effect during the desired transition.
Working with Parameter Groups

Each Final Effects Complete filter has parameter controls which appear in the Filters tab. Some filters include custom controls that you access by clicking the **Options button**.
Working with Layer Controls

Some filters include layer controls which let you use information from other media to control some aspect of the filter applied to the source media.

To use a layer control, click the **Layer Control button**. A window allows you to assign media to the layer control. If you do not drag a media file or sequence into the layer control, the source media is used.

---

Working with Point Controls

Many filters use point controls to specify locations along the X and Y axis in the source image. You can enter and edit point control values using the following methods:

- Click the cross-hair and click the mouse at the desired location in the Viewport.
- Click the numerical values and enter new values.
- Highlight the numerical values and scrub the pen or mouse to finetune the position of the crosshair.
- Double-click the numerical values and enter a value in the Calculator.
Getting Started

Working with Color Controls

Color controls are used to choose a color for some attribute of a filter or object, such as a light source, border, or text face. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen.
Understanding Contextual Controls in Combustion

The Combustion architecture does not support contextual controls, so parameters that do not apply are not dimmed. This means that a parameter may not apply unless other parameters are met.

Hiding a Filter

Hide an FEC filter the same way you would any other filter. Click the Filters Controls and toggle the Enabled button.

Resetting a Filter

Reset a FEC filter the same way you would any other filter. Click the Filters Controls and click the Reset button.
Applying Final Effects Complete in Boris Red, Graffiti or FX

1. Select the track to which you want to apply a filter. You can apply a filter to any shape, face, or container track.

2. Use one of the following methods to apply a filter.
   - Choose a filter from the Filters menu or press Command-F (Macintosh) or Control-F (Windows) to apply the last used filter.
   - Drag a filter from the Filter Palette to the timeline. For more information, see your Boris User Guide.

The filter track is nested inside the Face of the track to which it is applied. In this example, a Ripple filter is nested inside the Grasses.pct track. The filter track also contains separate tracks for each animatable parameter.
Chapter 2
Blur & Sharpen Effects

Introduction .................................................................30
FE Blur Filter ...............................................................30
FE Channel Blur ..........................................................30
FE Chroma/Luma Blur ....................................................30
FE Directional Blur .......................................................30
FE Vector Blur with Vector Map ........................................30
FE Sharpen .................................................................30
FE Soften .................................................................30
FE Spin Blur ...............................................................30
FE Spiral Blur .............................................................30
FE Unsharpen Mask .......................................................30
FE Zoom Blur .............................................................30
Introduction

This chapter describes the FE Blur and Sharpen effects.

In the descriptions that follow, sizes and distances are measured in pixels. Some panels provide labeled expansion buttons that toggle to reveal or hide additional controls.
FE Blur Filter

The FE Blur filter softens image detail. Sharp edges are lost while large features remain. This effect gives you precise control over blurring in the horizontal or vertical direction and allows separate blur amounts in individual channels in both YIQ and RGBA space.

![Unfiltered Image](image1) ![Filtered Image](image2)

The Kind of Blur menu sets the type of blur. The choices include:

- **Box** blurs the image with a boxcar algorithm.
- **Fast** approximates the Gaussian Blur but uses a faster algorithm.
- **Gaussian** blurs the image by convolution with a two-dimensional Gaussian (bell-shaped) curve.

The Channels menu defines which channel or combination of channels the blur affects. The first section allows you to blur the YIQ channels of the NTSC chrominance and luminance color space. Blurring the chroma makes color bleed while maintaining features in the image. Blurring the luminance softens the transitions between light and dark objects while keeping the boundaries between colors sharply defined. The Channels menu contains four options:

- **Luminance** blurs the Luminance channel.
- **Chroma** blurs the Chroma Channels (I and Q).
- **In Phase Chrominance** blurs the In Phase Chrominance channel (I) and the Quadrature Chrominance.
- **Quadrature Chrominance** allows you to blur the Quadrature Chrominance Channel (Q).

The second section applies the blur to one of the following channels: RGBA, RGB, Red, Green, Blue or Alpha.

Horizontal controls the amount of horizontal blur; Vertical controls the amount of vertical blur. If the Link Vertical checkbox is selected, the Vertical blur uses the same value as the Horizontal blur.
FE Channel Blur

The **FE Channel Blur** effect gives you precise control over blurring in the horizontal or vertical directions and the amount of separate blur amounts for the red, green, blue, and alpha channels.

The **Type of Blur menu** determines the type of blur. The choices include:

- **Box** blurs the image with a boxcar algorithm.
- **Fast** approximates the Gaussian Blur.
- **Gaussian** blurs the image by convolution with a two-dimensional Gaussian (bell-shaped) curve.

The **Link Vertical checkbox** sets whether or not vertical is linked to horizontal. If enabled, vertical blur is the same as horizontal blur.

- **Red Horizontal/Vertical** sets the amount of blur in the Red Channel.
- **Green Horizontal/Vertical** sets the amount of blur in the Green Channel.
- **Blue Horizontal/Vertical** sets the amount of blur in the Red Channel.
- **Alpha Horizontal/Vertical** sets the amount of blur in the Alpha Channel.
FE Chroma/Luma Blur

The FE Chroma/Luma Blur effect blurs the YIQ channels of the NTSC luminance and chrominance color space.

This effect lets you to blur the Luminance channel (Y), the Chroma channels (I and Q), or the In Phase Chrominance channel (I). Vertical and horizontal blurs have separate controls or you can link the controls together as one.

- Blurring the chroma makes colors bleed while maintaining features in the image.
- Blurring the luminance softens the transitions between light and dark objects while keeping the boundaries between colors sharply defined.

The Blur menu controls which channel is blurred. The choices are:

- **Luminance** blurs the Luminance channel.
- **Chroma** blurs the Chroma Channels (I and Q).
- **In Phase Chrominance** blurs the In Phase Chrominance channel (I) and the Quadrature Chrominance.
- **Quadrature Chrominance** blurs the Quadrature Chrominance Channel (Q).

**Link Vertical** controls whether or not vertical is linked to horizontal. If enabled, both horizontal and vertical are controlled by the Horizontal control.

**Horizontal/Vertical** controls horizontal and vertical blur.

The **Do Alpha checkbox** controls whether or not the Alpha channel (matte) is blurred. If the Do Alpha checkbox is not selected, the original Alpha channel is preserved.
FE Directional Blur

The FE Directional Blur effect produces a directional blur or smear. The blur option produces a constant blur throughout the layer. The smear option works in conjunction with the Falloff control to enable ease-in/ease-out control of the effect.

Unfiltered Image  Filtered Image

The Kind menu chooses symmetric motion blur or asymmetric motion smearing. The choices are Blur or Smear.

Direction controls the direction of the motion blur or smear. It ranges from -360 to 360 degrees.

Blur Length sets the distance of the motion blur.

Falloff controls how quickly the spin smear falls off. This control only affects the smear option. It ranges from 0 to 100%. A value of 0 causes the smear to continue at the same strength to the maximum length. A value of 100 causes no smear.

Antialiasing adjusts the amount of antialiasing applied.
FE Vector Blur with Vector Map

The FE Vector Blur effect gives an image a painted look by defining a vector field along which the blur will take place. There are various ways to define the vector field. For example, use the default settings and animate the Mode Angle direction while keyframing the Blur Length for a ghostly look.

The FE Vector Blur is a dual-input effect. You can input another clip on which to base the vector for the blur.

Unfiltered Image  Filtered Image

The Vector Type menu sets how the vector field is defined from the values in the chosen Vector Map. Choose one of the following options.

- **Natural** forms the vector field from slopes in the Vector Map from which values define height. Smoothness and steepness in the Vector Map affect vector length and also blur length.
- **Constant Length** has the same affect as Natural, but with straight blur strength, not fading.
- **Perpendicular** has the same affect as Natural, but with perpendicular vectors. Vectors don’t point up and down the slopes, instead they point along the slopes, around hills.
- **Direction Center** assumes vector field directions from the values of the Vector Map. High and low values point in different directions. Vector lengths do not vary. This blurs in both directions from the center of the vectors.
- **Direction Fading** has the same affect as Direction Center except this only blurs in the (one) direction of the vectors.

Modify Angle specifies the angle of blur for Directional blurs.

The Vector Map layer control sets a Vector Map from which the vector field is defined. For example, selecting a layer containing animated Fractal Noise can produce very interesting effects.
The **Base Field** on menu controls how the Directional settings curl each brush stroke. Extra control defines how many circles or revolutions the blur stroke makes around the center. The options include: **Red, Green, Blue, Alpha, Luminance, Lightness, Hue,** and **Saturation.**

Setting the Extra control causes visual echoes and trails around the edges of an object. Each revolution adds another echo to the edge as the strokes are added together. This can affect the depth of non-directional blurs.

**Blur Length** controls how far along the vector is blurred. Animating this setting at higher positive values along with the extra slider creates longer trails.

**Map Softness** determine the softness (or blurring) of the vector field. Higher Map Softness values remove small details and make the blur appear smoother. This parameter measures how far the curl reaches out from the center of the stroke along the Blur Length. In conjunction with the Extra parameter, **Map Softness** defines the spiral amount of the curl. For non-directional blur types, this setting spreads the brush stroke.
FE Sharpen

FE Sharpen increases the contrast of the color edges in an image. The effect is to make these edges more distinct. Noise or graininess is also enhanced. The effect is very local, mixing only adjacent pixels.

Unfiltered Image  Filtered Image

The Channels menu sets the channel or combination of channels on which to apply the effect. The choices include: RGBA, RGB, Red, Green, Blue, and Alpha.

The Amount controls the amount of sharpening. It ranges from 0 to 100 relative levels of sharpening.
FE Soften

FE Soften makes the color edges of an image less distinct and reduces noise or graininess. The effect is local, mixing only adjacent pixels.

The Channels menu sets the channel or combination of channels on which to apply the effect. The choices include: RGBA, RGB, Red, Green, Blue, and Alpha.

The Amount controls the amount of sharpening. It ranges from 0 to 100 relative levels of sharpening.
**FE Spin Blur**

FE Spin Blur produces either a blur or smear that is controlled by spinning the layer around a center point.

![Unfiltered Image](image1) ![Filtered Image](image2)

The **Kind menu** sets the type of blur to produce. The choices include:

- **Blur** produces a constant blur throughout the layer.
- **Smear** works in conjunction with the Falloff control to enable ease-in/ease-out control of the effect.

**Spin Amount** ranges from -360 to 360 degrees. This specifies the amount of the angle to blur or smear. A negative blur value is the same as a positive blur value.

**Falloff** controls how quickly the spin smear falls off. This control only affects the smear option. It ranges from 0 to 100%. A value of 0 causes the smear to continue at the same strength to the maximum length. A value of 100 causes no smear.

**Center** sets the location around which the effect is applied.

**Antialiasing** adjusts the amount of antialiasing applied.
FE Spiral Blur

The FE Spiral Blur combines FE Spin Blur and FE Zoom Blur. It produces either a blur or smear that is controlled by spinning the layer around a center point while also zooming toward or away from this same center point.

![Unfiltered Image](image1) ![Filtered Image](image2)

The **Kind menu** sets the type of blur to produce. Choose one of the following options:

- **Blur** produces a constant blur throughout the layer.
- **Smear** works in conjunction with the Falloff control to enable ease-in/ease-out control of the effect.

**Zoom %** controls the zoom in and zoom out of the image.

**Spin Amount** specifies the amount of the angle to blur or smear. A negative blur value is the same as a positive blur value. It ranges from -360 to 360 degrees.

**Falloff** controls how quickly the spin smear falls off. This control only affects the smear option. It ranges from 0 to 100%. A value of 0 causes the smear to continue at the same strength to the maximum length. A value of 100 causes no smear.

**Center** sets the location around which the effect is applied.

**Antialiasing** adjusts the amount of antialiasing applied.
FE Unsharpen Mask

The FE Unsharpen Mask increases the contrast between colors that define an edge while adjusting the edge detail to make the image appear sharper.

The Channel menu sets the channel or combination of channels to which to apply the effect. It includes the following choices: RGBA, RGB, Red, Green, Blue, and Alpha.

Amount controls the degree by which the brightness of edge pixels is increased. The higher the value, the stronger the effect of the filter.

Link Vertical controls whether or not vertical is linked to horizontal. If Follow Horizontal is enabled, both horizontal and vertical are controlled by the Horizontal control.

Horizontal/Vertical Radius defines the number of pixels surrounding the edge to which the sharpening effect is applied. A high value adjusts more of the pixels surrounding the edge for contrast. A low value adjusts only the pixels at the edge.

Threshold specifies a tolerance to define edges and prevent overall contrast adjustment that might generate noise or cause unexpected results. It defines the range of contrast between adjacent pixels before contrast is adjusted. A lower value produces a more pronounced affect.
FE Zoom Blur

FE Zoom Blur produces either a blur or smear, resulting from zooming toward or away from a center point.

Unfiltered Image  Filtered Image

The **Kind menu** sets the type of blur to produce. The choices are:

- **Blur** produces a constant blur throughout the layer.
- **Smear** works in conjunction with the Falloff control to enable ease-in/ease-out control of the effect.

**Zoom %** controls the zoom in and zoom out of the image.

**Spin Amount** specifies the amount of the angle to blur or smear. A negative blur value is the same as a positive blur value. It ranges from -360 to 360 degrees.

**Falloff** controls how quickly the spin smear falls off. This control only affects the smear option. It ranges from 0 to 100%. A value of 0 causes the smear to continue at the same strength to the maximum length. A value of 100 causes no smear.

**Center** sets the location around which the effect is applied.

**Antialiasing** adjusts the amount of antialiasing applied.
Chapter 3
Color Correction Effects

Introduction ............................................................... 44
FE Brightness and Contrast ........................................ 45
FE Color Balance (HLS) ............................................... 46
FE Color Balance (RGB) ............................................... 47
FE Color Offset .......................................................... 48
FE Threshold ............................................................. 49
FE Threshold RGB ....................................................... 50
FE Toner ................................................................. 51
FE Gamma-Pedestal-Gain ........................................... 52
FE Invert ................................................................. 53
FE Levels ................................................................. 54
FE Replace Color ......................................................... 56
FE Tint ................................................................. 57
Introduction

This chapter describes the FE Color Correction effects.

In the descriptions, sizes and distances are measured in pixels. Some panels provide expansion buttons that toggle to reveal additional controls.
**FE Brightness and Contrast**

**FE Brightness and Contrast** lets you independently adjust the brightness and contrast of an image.

![Source image](image1) ![Filtered image](image2)

**Brightness** controls the lightness of the pixels in the image. Increasing its value lightens the pixels in the image.

**Contrast** controls the image contrast. Increasing its value makes light pixels lighter and dark pixels darker.
FE Color Balance (HLS)

FE Color Balance (HLS) changes the color in an image by independently adding or subtracting Hue, Lightness, or Saturation values (HLS).

Hue controls the color scheme of the image. Most color corrections require very small changes in the Hue setting; adjustments of 10° or less usually suffice. Adjustments larger than 10° usually produce more dramatic color changes.

Lightness controls the lightness or darkness of the image.

Saturation controls the color intensity of the image.
FE Color Balance (RGB)

FE Color Balance (RGB) changes the color in an image by independently adding or subtracting from the red, green, or blue values (RGB).

Red sets the color balance in the Red channel.
Green sets the color balance in the Green channel.
Blue sets the color balance in the Blue channel.
FE Color Offset

FE Color Offset lets you rotate the value of each color channel. The rotation Start point is the original value for that color channel.

Red Offset, Green Offset and Blue Offset set the rotation value for each color channel, respectively.

The Overflow Behavior menu sets the overflow methods. Overflow occurs when colors become too bright. Choose from the following options.

- The **Wrap** option wraps the overflow around darker values.
- **Solarize** reflects the color overflow back to lower values. Solarize creates a surrealistic look by accentuating cooler values.
- **Polarize** increases the color vibrancy by accentuating warmer values and enhancing details. The reflection is smoother than the reflection created by Solarize.
FE Threshold

FE Threshold is useful for creating a mask from a footage file that does not currently have an alpha channel.

Threshold defines the level below which pixels are filled with dark values. The range is from 0 to 256. A setting of 256 gives a complete threshold to black effect.

The Threshold menu lets you choose the data to apply to the threshold.

- Choose Luminance to limit the resulting image to black and white based on the threshold value selected.
- Choose RGB to threshold the red, green, and blue channels separately. RGB values are derived from the channels in the source image.

Invert reverses the colors of the current image.

Blend with Original lets you set a transparency level for compositing the effect with the original image. A value of 100% shows only the original image; a value of 50% produces an even blend between the effect and the original image.
**FE Threshold RGB**

**FE Threshold RGB** lets you create thresholds based on individual red, green, or blue values.

Red Threshold, Green Threshold, and Blue Threshold set the Red, Green, and Blue threshold. The range is from 0 to 256. Only values that you select are allowed in the final image. RGB values are derived from the RGB channels of the original image.

Selecting the Invert Red Channel, Invert Green Channel, or Invert Blue Channel checkboxes reverses the respective color channel.

Blend with Original lets you set a transparency level for compositing the effect with the original image. A value of 100% shows only the original image; a value of 50% produces an even blend between the effect and the original image.
**FE Toner**

**FE Toner** is a color-mapping effect that applies a three-point color ramp based on the luminance of the source image. The three points of the color ramp correspond to the highlight, midtones, and shadows of the image. Choose any three colors for the ramp.

![Source image](image1) ![Filtered image](image2)

**Highlights, Midtones, and Shadows** let you choose colors to map from a color palette.

**Blend with Original** blends the source and filtered images. Use this parameter to animate the effect from the unfiltered to the filtered image without adjusting other settings, or to reduce the effect of the filter by mixing it with the source image. A value of 100% shows only the original image; a value of 50% produces an even blend between the effect and the original image.
FE Gamma-Pedestal-Gain

FE Gamma-Pedestal-Gain alters the color channels, independently or as a group, by allowing you to change the gamma, pedestal, and gain. **Gamma** defines or controls midtone gray level values. Use Gamma to alter the midtones without affecting the shadows or highlights. **Pedestal** defines or controls the shadow values. Use Pedestal to alter shadow values without affecting the midtones or highlights. **Gain** defines or controls the highlight values without affecting shadows or midtones.

**Black Stretch** remaps channel low pixel values. This control always applies equally to all channels.

**All Follow Red** controls whether the color channels are changed independently or simultaneously with the Red channel. It changes the color channel with the Red channel when enabled.

**Red/Green/Blue Gamma** controls the midtone gray values for each channel.

**Red/Green/Blue Pedestal** controls the shadows for each channel.

**Red/Green/Blue Gain** controls the highlight values of each channel.
**FE Invert**

**FE Invert** reverses the color information of a layer.

The **Channel menu** sets the color channel, color space, or alpha channel to reverse. Choose an option from the **Additive menu:** *RGB, Red, Green, and Blue.*

- The **Calculated** color group options include: *HLS, Hue, Lightness,* and *Saturation.*
- The **NTSC** group includes the following choices: *YIQ, Luminance, in Phase Chrominance,* and *Quadrature Chrominance.*
- The **Alpha** group includes the following options: *Alpha.*

**Blend with Original** sets the amount of blending between the inverted and original image.
FE Levels

FE Levels remaps the input color levels onto a new range of output color levels, and changes the gamma correction at the same time. The Levels effect is useful for basic image quality adjustment.

The Channel menu sets the color channel to be modified.

Histogram shows how the pixel values are distributed in an image.

Input Black/White sets the threshold of the black or white value for the input image. It ranges from 0 to 255.

Gamma sets the gamma value, which is represented by the middle triangle below the histogram.

Output Black/White sets the threshold of the black or white value for the output image. It ranges from 0 to 255.

Red Input Black/White sets the threshold of the red value for the input image. It ranges from 0 to 255.

Red Gamma sets the red gamma value adjustment from the main gamma level.

Red Output Black/White sets the threshold of the red value for the output image. It ranges from 0 to 255.

Green Input Black/White sets the threshold of the green value for the input image. It ranges from 0 to 255.

Green Gamma sets the green gamma value adjustment from the main gamma level.

Green Output Black/White sets the threshold of the green value for the output images. It ranges from 0 to 255.

Blue Input Black/White sets the threshold of the blue value for the input image. It ranges from 0 to 255.
Blue Gamma sets the blue gamma value adjustment from the main gamma level.

Blue Output Black/White sets the threshold of the blue value for the output image. It ranges from 0 to 255.

Alpha Input Black/White adjusts the pure black or white input areas of an Alpha channel to be semitransparent, or adjusts input grays (semitransparent areas) to be pure black or white.

Alpha Gamma sets the alpha gamma value adjustment from the main gamma level.

Alpha Output Black/White adjusts the pure black or white output areas of an Alpha channel to be semitransparent, or adjusts output grays (semitransparent areas) to be pure black or white.
FE Replace Color

FE Replace Color replaces a color with another color, or keys out the selected color to make areas with that color transparent. FE Replace Color provides controls for Hue, Lightness, and Saturation Tolerance, which you can set to define color criteria. A color matching scheme then uses those criteria to replace or key a color.

The View menu determines which layer is displayed. The choices are Corrected Layer and Color Correction Mask.

Key Selection keys out the selected color. If the checkbox is enabled, the color specified in Source/Key Color is keyed out.

Source/Key Color sets the Red, Green, and Blue channels for the source/key color.

Hue Tolerance controls the range of hues matching the color to replace.

Lightness Tolerance controls the range of lightness values matching the color to replace.

Saturation Tolerance controls the range of saturation of colors matching the color to replace.

Match Softness controls the match criteria. As Match Softness approaches the value of 0%, all colors within tolerance are more completely affected. A value of 0% results in a hard match; all matching colors are completely affected. A value of 100% affects colors that match exactly and partially affects nearby colors.

Invert Selection reverses the specified color replacement. For example, colors that do not match now match, colors that do match no longer match. Partial matches are also reversed.

Hue Transform controls the progression of the hue of the replacement color. It ranges from -360 to 360.

Lightness Transform controls the lightness, or brightness, value of the replacement color.

Saturation Transform controls the saturation value of the replacement color.
FE Tint

FE Tint changes the color information of an image. Control these changes by specifying the color to which black and white are mapped.

Map Black to controls which colors map to black.
Map White to controls which colors map to white.
Amount to Tint controls the amount of tinting applied.
Chapter 4
Distort Effects

Introduction .................................................. 60
FE Bulge ...................................................... 61
FE EZ LazyWaves .......................................... 62
FE EZ Ripples ................................................ 63
FE Bend It ..................................................... 64
FE Bender ..................................................... 65
FE Flo Motion ............................................... 66
FE Griddler .................................................. 67
FE Lens ....................................................... 68
FE Power Pin ............................................... 69
FE Ripple Pulse ............................................ 70
FE Slant ....................................................... 71
FE Slant Matte ............................................. 72
FE Smear ..................................................... 73
FE Spherize .................................................. 74
FE Split ....................................................... 75
FE Split 2 ..................................................... 76
FE Tiler ....................................................... 77
FE Twirl ....................................................... 78
FE WaterWaves ........................................... 79
Introduction

This chapter describes the FE Distort effects.

In the descriptions, sizes and distances are measured in pixels. Some panels provide expansion buttons that toggle to reveal additional controls.
FE Bulge

FE Bulge symmetrically distorts an image around a center point to give the impression of a bulge around that point. You can independently control the size and amount of the distortion.

Center specifies the location around which the effect is applied.

Width Follows Height controls whether the width and height values change together or separately. If enabled, the width and height values change together.

Height indicates what percentage of the image height to distort.

Width indicates what percentage of the image width to distort.

Depth controls how much the image is pushed in or pulled out.
**FE EZ LazyWaves**

FE EZ LazyWaves is an easy-to-use subset of FE WaterWaves that gives you quick control over wave direction and speed. The waves are self-animating after you set the speed.

![Unfiltered Image](image1.png) ![Filtered Image](image2.png)

**Speed of Waves** specifies the speed of the waves.

**Average Direction** specifies the direction of the waves. It ranges from -360 to 360 degrees.

**Random Seed** specifies a random speed value from which wavelength and orientation are generated. This control randomly changes the effect. It ranges from 0 to 32767.
FE EZ Ripples

FE EZ Ripples is an easy-to-use subset of FE WaterWaves. It gives you quick control over wave direction and speed. Waves are self-animating after you set the speed of the waves.

Speed of Waves specifies the speed of the waves.
Average Direction specifies the direction of the waves. It ranges from -360 to 360 degrees.
Random Seed specifies a random speed value from which wavelength and orientation are generated. This control randomly changes the effect. It ranges from 0 to 32767.
FE Bend It

FE Bend It warps an image. This effect produces a true bend, not a displacement. For examples, you can use this effect to make a flag wave in the breeze.

![Unfiltered Image](image1.png)  ![Filtered Image](image2.png)

**Start and End** set reference points that act as the handles the effect uses to bend the image. **Bend** sets the amount of bend applied to the image. Positive values bend one way; negative values bend the other. A value of 100 produces a complete bend and the opposite sides of the image meet.

Set a key frame at the start and end positions to animate a wave through the image.

The **Render Prestart menu** lets you choose how to render the region before the Start point.

- **None** does not render imagery before the Start point.
- **Static** renders the image before the Start point without bending.
- **Bend** continues to bend the image before the Start point.
- **Mirror Bent** mirrors the image between the Start and End point across the Start point.

The **Distort menu** specifies how to render the regions beyond the End point.

- Choose **Legal** to cut the layer beyond the End point.
- Choose **Extended** to render to the extent of the image.
FE Bender

FE Bender creates a distortion between two points in an image. This effect gives the illusion of bending and can be used to create realistic waving or swaying effect.

To animate an image with this effect, you must set at least two keyframes using different bend values or control points for each keyframe.

Point A and Point B set the Start and End points for the Bender effect.

The Bend Style menu specifies the overall look of the distortion used in the effect. Choose from the following options:

- **Empire State** bends only at the End point, creating a dramatic perspective.
- **Marilyn** creates a curvaceous look, bending smoothly from Point A to Point B.
- **No. 5** produces a triangular bend from Point A to Point B, creating a sharp angular look.
- **Boxer** creates a simple straight-forward distortion.

Bend controls the strength and relative direction of the bend. Positive numbers bend one way; negative numbers bend the other way.

Absolute Value specifies that the Bend amount is an absolute value. By default, the Bend amount is relative to the distance between Point A and Point B.
FE Flo Motion

FE Flo Motion produces a vortex distortion similar to a black hole pulling in or ejecting an object.

**Unfiltered Image**  **Filtered Image**

**Control option** increases sensitivity by a factor of 20. A setting of 1.00 with Fine Controls enabled is equivalent of .05 with Fine Controls disabled. When enabled, Fine Controls are applied equally to any active knot.

**Knot 1** and **Knot 2** specify where the Flo Motion effect begins or ends. Knots are like vortices that pull the image in or push it out. One or both knots can be active at any time and you can move the knots where you want the effect to begin or end.

**Amount** activates the knot. Zero makes the knot inactive. Higher values increase the iterations and produce more exaggerated effects.

**Wrap Edges** produces seamless symmetrical tiling. This control fills the screen with tiles of the Flow Motion image. For more tiles, choose a higher setting for the Knots.

**Antialiasing** creates a smoother blending between the layer to which you apply it and any background layers or objects.

**Falloff** fine tunes the intensity of an effect without changing the other settings. The lower the Falloff value, the more concentrated the vortex and the larger the number of tile iterations. A value of 0 produces the highest concentration. A value of 10 produces no Falloff.
**FE Griddler**

*FE Griddler* creates a tiled version of an image while scaling and rotating the tiles. Use this effect to cut an image into squares and animate it.

The smaller the size setting you use, the more tiles that appear in the image.

**Unfiltered Image**  
**Filtered Image**

**Horizontal Scale** and **Vertical Scale** scale the image content of the tiles.

- Setting both scales to 100% fills the tiles completely with pieces of the original image when they begin to rotate.
- Setting both scales to 50%, scales the amount of the image visible in each tile down by half, making the tiles appear only half full.
- Setting a negative value inverts and scales the image. An image scaled to –100% is a mirror image of the +100% image.

**Tile Size** sets the dimensions of the actual tiles. Set the image content of the tiles in **Scaling**.

**Rotation** sets the angle of the tiles. Set keyframes to rotate the tiles.

**Cut Tiles** inserts a border between the tiles so that they are not completely full. The effect is similar to adding invisible grouting between tiles.

- When selected, the area between the tiles is transparent. Any layer below shows through. If there are no layers below, the space between tiles is black.
- When deselected, no visible border appears between tiles. The effect samples perimeter color data to compensate for the void left transparent by the cut tiles.
**FE Lens**

**FE Lens** creates a lens distortion effect. The distortion can be away from or toward the center.

![Unfiltered Image](image1) ![Filtered Image](image2)

**Center** sets the center point of the distortion.

**Size** sets the size of the lens in relation to the entire image. It determines the radius of the lens effect.

**Convergence** controls the lens shape.

- A low setting stretches and distorts the image over the outside of an invisible sphere (much like Spherize).
- A higher setting stretches and distorts the image outward from the center, as if it were on the inside of a bowl or a crystal ball.
**FE Power Pin**

The **FE Power Pin** effect lets you slant, scale, and apply perspective to a layer. FE Power Pin lets you treat a layer as if it was on a sheet of rubber. You can stretch any corner and “pin it in place.”

Unfiltered Image  Filtered Image

**Scrubbers** control the movement, perspective, and scale of the image. Scrubber choices include:

- Use **Move** to drag the imagery within the layer.
- **Grid** allows you to toggle the Perspective control between 0 and 100%.
- Use **Scale** to drag up/down or left/right to scale the image in that dimension.

**Top Left** slants or scales the image to the top left.

**Top Right** slants or scales the image to the top right.

**Bottom Left** slants or scales the image to the bottom left.

**Bottom Right** slants or scales the image to the bottom right.

**Perspective** adds perspective using foreshortening. It gives the perspective that the upper portion of the image is farther away.

- Imagery toward the top layer is compressed.
- Imagery toward the bottom is expanded.

**Unstretch** inverts the function of the pins.
FE Ripple Pulse

FE Ripple Pulse creates a user-definable ripple wave similar to the effect of a pebble dropped into a pool of still water. The strength, speed, center point, and height of the ripple are all fully controllable.

To create a good ripple, use two keyframes, giving the first keyframe a lower Pulse value and the second keyframe a relatively high value.

![Unfiltered Image](image1)  ![Filtered Image](image2)

**Center** determines the origin of the ripple effect.

**Pulse Level** controls the strength of the pulse creating the ripple. This control must be keyframed.

**Time Span** sets the outward speed of the ripple.

**Amplitude** describes the height of the ripple crest.

- Higher values increase the height of the ripple wave/distortion.
- Lower values create a smoother ripple.

**Bump Map** treats the animated ripple as a bump map, which can then be used by any other effect that works with bump maps (such as FE Glass).
FE Slant

FE Slant tilts the image horizontally.

Unfiltered Image  Filtered Image

Slant controls the direction and amount of slant.
- Higher values tilt the image to the right
- Lower values tilt the image to the left

Floor sets the baseline for the tilt effect.

Height controls the vertical scale of the slanted image.
- Moving the slider toward 0.00 compresses the image vertically.
- Moving the slider toward 1 gradually restores the image to full height.
FE Slant Matte

FE Slant Matte creates a matte color slant of the image. This is useful for creating shadows behind text and other images.

Unfiltered Image  Filtered Image

Slant controls the direction and amount of slant.
- Higher values tilt the image to the right
- Lower values tilt the image to the left

Floor sets the baseline for the tilt effect.

Height controls the vertical scale of the slanted image.
- Moving the slider toward 0.00 compresses the image vertically.
- Moving the slider toward 1 gradually restores the image to full height.

With Matte Color you can choose the image color. This color replaces the imagery.
FE Smear

FE Smear allows you to create warping distortion effects that you can animate. FE Smear creates a warp based on a start point and moving toward an end point. You can apply multiple FE Smear effects to your source image and put the From and To points of each application in different positions to create great warping effects.

From and To set the start and end position of the distortion effect. The image warp starts at the From point and warps toward the To point.

Completion describes the amount of warping.

Radius sets the size of the area to be distorted.
FE Spherize

FE Spherize distorts a circular or elliptical portion of the image to create the illusion that it rests upon or wraps around a sphere or ellipsoid. You can control the size and amount of the distortion. Independently changing the height and width values will create an ellipsoid-shaped effect.

Unfiltered Image  Filtered Image

Center specifies the location around which the effect is applied.

Width follows Height controls whether the width and height values change together or separately. If enabled, width follows height.

Clip to Sphere cuts away parts of the image outside the sphere when enabled.

Height indicates what percentage of the image height to distort.

Width indicates what percentage of the image width to distort.

Depth controls how much the image is pushed in or pulled out.

- A value of 100 causes a bulbous effect.
- A value of -100 causes a sunken effect.
**FE Split**

**FE Split** splits the source image. Animating the amount of splitting can create effects similar to a mouth or zipper opening and closing.

![Unfiltered Image](image1) ![Filtered Image](image2)

**Point A** and **Point B** set the start and end of the split.  
**Split** controls the amount of splitting between the start and end point.
FE Split 2

FE Split 2 creates two splits in the source image. You define the shape of the split based on a curve drawn in the custom dialog.

Point A and Point B sets the start and end of the split. Place these points anywhere on the source image.

Split 1 controls the amount of splitting between the start and end points for the first split.

Split 2 controls the amount of splitting between the start and end points for the second split.

Custom Dialog displays a dialog box when you click the Custom UI button. Use the Options controls to adjust the curve of the split.

Presets lists the names for FE Split 2 current presets.

Canvas depicts the current curve in use in the area directly beneath the presets menu. Press and drag within this area to create custom curve to be used by FE Split.

Soften softens the current curve. Press and hold the dynamic Soften button for gradually increasing levels of softness.

Normalize normalizes the current curve, spreading the current minimum and maximum values across the entire range of legal values.
**FE Tiler**

**FE Tiler** scales down and tiles an image to fill the screen. With this effect, you define the amount of scaling and the center point around which to scale the image. This is useful for animating because it lets you scale the source from a set point.

![Unfiltered Image](image1) ![Filtered Image](image2)

**Scale** sets the size of the scaling. A setting of 100% keeps the image at its original size. Reducing the scale percentage scales the image down and tiles it to fill the screen.

**Scale Center** anchors the point from which to scale the image.

**Blend with Original** lets you set a transparency level for compositing the effect with the original image.
- 100% shows only the original image.
- 50% produces an even blend between the original and the tiled images.
- 0% produces only tiled images.
**FE Twirl**

**FE Twirl** distorts, twirls, and rotates the image around a center point using more rotation near the center and less rotation at the outer edges.

Unfiltered Image  Filtered Image

*Angle* controls the angle of the twirl.

*Twirl Radius* controls the radius of the twirl.

*Twirl Center* specifies the twirl center point.
**FE WaterWaves**

**FE WaterWaves** is a realistic modeling of wave reflection and refraction. The image is distorted to simulate refraction. Colors are composited over the distorted image to simulate reflections from the surface. The waves are self-animating after you set the speed.

Number of Waves specifies the number of waves to apply to the image.

Amplitude controls the wave height. This control specifies the RMS size of all the waves combined.

Speed of Waves specifies the speed of the average wave.

Average Direction specifies the direction of the average wave. It ranges from -360 to 360 degrees.

Direction Spread specifies the maximum angular separation permitted for the waves. It ranges from -360 to 360.

Average Wavelength specifies the length of the average wave.

Wavelength Spread specifies the maximum spread permitted for wave lengths. This value is a percentage of the Mean Wavelength.

Spotlight controls the position of a spotlight that reflects off the wave surface.

- Placing this point in the center of the image puts the spotlight directly in front of the image, causing reflections from flat surfaces.
- Placing this point away from the center shines the spotlight from that direction.

Spotlight Color specifies the color of the spotlight.

The Focus Type menu controls the type of spotlight view for the relief. The choices determine how the spotlight illumination falls off from the spotlight center and include: **Hard Edge, Broad, Normal, Narrow, and Laser**.

Spotlight Width specifies the size of the spotlight.
Top Color specifies the illumination from the top of the image.

Bottom Color specifies the illumination below the image.

Left Color specifies the illumination from the left of the image.

Right Color specifies the illumination from the right of the image.

Reflections specifies how much the colors reflect on the surface.

The Alpha Channel setting controls whether or not waves are placed in the Alpha channel. If enabled, the Alpha channel has waves. This discards the old Alpha channel and fills it with waves. This enables an effect, such as the 3D Relief effect, to illuminate the waves from many light sources.

Random Speed specifies the random seed value from which wave length and orientation properties are generated. It ranges from 0 to 32767.
Chapter 5
Edges Effects

Introduction .................................................. 82
FE Burn Edges .............................................. 83
FE Gradient Blur ............................................ 84
FE Power Ramp .............................................. 85
FE Sparkle Edges .......................................... 86
FE Spot Blur ................................................ 88
FE Spot Feather ........................................... 89
FE Spot Frame .............................................. 90
FE Spot Tatter .............................................. 91
FE Spot Turbulence ....................................... 93
FE Wiggle Edges .......................................... 94
Introduction

The FE Edges effects deal specifically with object edges. These filters accent the alpha and RGB borders of a selected layer. FE Edges enable you to feather and “tatter” the alpha edges of an object, or place treatments, such as sparkles and wavy lines, on the edges. FE Edges also allow you to quickly create “spot” effects without requiring the creation of a mask.

The following sections describe each effect with details of the controls.
FE Burn Edges

The FE Burn Edges effect simulates the burning of the edges of an object. It uses alpha information to determine the edges and gives you control over a number of burn controls.

**Burn Width** specifies the width of the effect in pixels.

If you select the **Disappearing Edge** checkbox, the edges erode.

The **Color** controls set the colors of the burnt edges and the erosion of the image on the burnt areas. **Color 1** specifies the color band closest to the edge. **Color 2** specifies the color band second from the edge. **Color 3** specifies the color band third from the edge. **Color 4** specifies the color band furthest from the edge.

**Color Blend** sets the extent of the blending of one color band with adjacent colors.

**Burn Progression** specifies how far the burnt edge progresses toward or away from the layer edge.

**Texture Amount** specifies the amplitude of a texture to be added to the burn colors, which gives a rough appearance to the color bands.

**Texture Grain Size** specifies the texture grain size.

**Burn Intensity** controls the strength of the burn colors as you composite them on the image.

The **Layer Border Options menu** allows you to choose the RGBA area outside the original layer border. Choose from **Repeat, Mirror, Transparent** and **Opaque**.

**Blend with Original** controls the transparency of the original layer without removing the effect result. As the value approaches 0, the original layer fades out.
FE Gradient Blur

The FE Gradient Blur filter allows you to apply a Gaussian blur along either a linear or radial gradient with precise control over blur positions and amounts. If you choose the Matte or Key parameter in Composite Options, the opacity links to the blur amount.

The Gradient Mode menu sets the shape of the gradient pattern to Linear or Radial.

Blur Alpha specifies whether or not to blur the alpha channel.

Positions 1, 2, 3, 4 specify one of four control points to apply the blur. The control points determine the orientation of the grid and the amount of blurring. You manipulate the control points with the mouse or with the Position 1 through 4 point picker fields in the panel. For ellipse and triangle shapes, Position 4 is not used. For circle shapes, Position 3 and 4 are not used.

Position 1, 2, 3, 4 Blur Amount controls how much blurring occurs around each control point.

The Compositing (Composite Options) menu lets you composite the effects onto the layer and allows you to create mattes and keys. Matte options place the effect on the image according to the specified matte command. Key options use the effect result as a reference object to “key on” and create a transparency in the layer. Choose from the following options: Blur, Inverse Blur, Matte Blur, Matte Inverse Blur, Key Blur, and Key Inverse Blur.

The Layer Border Options menu lets you define the RGBA area outside an original layer border. Choose Mirror or Transparent.
FE Power Ramp

FE Power Ramp applies a four-point color gradient to a layer and can be used to generate interesting textures that animate over time. Ramp Noise is available to combat the banding that can occur when working with gradients in broadcast color space.

When you place two Ramp Position points at the same location, the resulting color is a smooth gradient of the point colors, rather than a sharp line of different colors.

The Ramp Mode menu sets the type of gradient.

- **Linear** places the Color 1 at the left and blends toward the Color 4 at the right.
- **Radial** places the Color 1 at the center and blends outward toward the Color 4

Position 1, Position 2, Position 3, and Position 4 specify one of four control points to define color. The control points determine the orientation of the grid.

Ramp Color 1, Ramp Color 2, Ramp Color 3, and Ramp Color 4 set the color at the selected position.

Ramp Noise Amount sets the amount of the noise texture.

Ramp Noise Blur sets the blurriness of the noise texture and controls the size of the texture or granularity.

Ramp Noise Frequency sets the frequency of the noise texture.

The Ramp Noise Channel menu sets which channels receive the noise. Choose from None, RGBA, RGB, RGBA mono, RGB mono, Alpha, Red, Green, and Blue.

The Transfer Mode menu controls how the effect composites with the filtered layer.

Blend with Original controls the transparency of the original layer without removing the effect result. As this value approaches 0, the original layer fades out.
FE Sparkle Edges

FE Sparkle Edges places sparkles on the alpha edge of the image. You have control over a number of sparkle properties, including the placement of the sparkles and the manipulation of the sparkle edge itself. The sparkles can remain stationary or can self-animate to move in random orbits. They can also be programmed to blink on and off rapidly, or fade up and down slowly.

Sparkle Density specifies the density of sparkles.

Sparkle H. Size specifies the horizontal size of the sparkles.

The Vertical follows checkbox controls whether the Vertical value is linked to the Horizontal value when sizing the sparkle. If you enable the Vertical follows checkbox, the vertical sparkle size equals the horizontal sparkle size.

Sparkle V. Size sets the vertical size of the sparkles.

Edge Offset sets the position of sparkles relative to the alpha edge.

Edge Sensitivity sets how closely the sparkles follow the details of the alpha edge.

The Show checkbox allows you to view the sparkle map. White areas in the sparkle map indicate where sparkles will appear. The map is drawn using the average of Sparkle Color A and Sparkle Color B.

H. Edge Range specifies the horizontal range to which the sparkle band extends.

The Vertical follows checkbox controls whether the Vertical Edge Range value is linked to the Horizontal Edge Range value when setting the sparkle range. If you enable the Vertical follows checkbox, the vertical sparkle range equals the horizontal sparkle range.

V. Edge Range specifies the vertical range to which the sparkle band extends.

Sparkle Strength controls the intensity of the sparkle.

Sparkle Color A and Sparkle Color B set the sparkle colors. A color palette and eyedropper are provided to choose your color.
Color Randomness specifies additional color deviation to produce colors outside the Color A and Color B range.

Orbit Speed controls the speed of the sparkle motion across the image.

Orbit Size controls the area in which the sparkle move.

Viewable Sparkles defines how many of the sparkles are visible or not at any particular time.

Flash Frequency sets how often the sparkles flashes.

Fade Flash controls how the sparkle flash changes. If you activate the Fade On checkbox, the sparkle changes gradually. Otherwise, the sparkle flash changes abruptly.

The Composite Options menu allows you to control the compositing of effects onto the layer and create mattes and keys. Matte options place the effect result onto the image according to the specified matte command. Key options use the effect result as a reference object to “key on” and create a transparency in the layer. Choose from Matte Sparkles on Top, Matte Sparkles Behind, Key Sparkles, and Key Inverse Sparkles.

The Layer Border Options menu lets you define the RGBA area outside an original layer border. Choose from Repeat, Mirror, Transparent, and Opaque.

Blend with Original controls the transparency of the original layer without removing the effect result. As the value approaches 0, the original layer fades out.
FE Spot Blur

The **FE Spot Blur** allows you to define a spot on a layer and blur it. You control the blur amount, including a control to blur the alpha channel. You have precise animation control available for the spot properties, including shape, position, and border width.

**Blur Amount** controls how much blurring occurs around the designated spot.

**Blur Alpha** specifies whether or not to blur the alpha channel. If you activate the **Blur Alpha** checkbox, the alpha channel is blurred.

The **Spot Shape menu** specifies the shape of the blurred area. The choices include: **Triangle**, **Quadrilateral**, **Ellipse**, **Circle**, **Rectangle**, and **Parallelogram**.

**Position 1, 2, 3, 4** specifies one of four control points to apply the blur. The control points determine the orientation of the grid and the amount of blurring. Manipulate the control points with the mouse or with the point picker fields in the panel. For ellipse and triangle shapes, Position 4 is not used. For circle shapes, Position 3 and 4 are not used.

**Border Width** specifies the amount of the border around the blur spot area.

The **Border Position menu** helps locate a spot on an image, and defines how the border is placed relative to the spot boundary. The choices include: **Inside**, **Centered**, and **Outside**.

**Spot Angle** controls the orientation of the spot.

The **Rotate About menu** specifies the point around which the feathered area rotates. Choose from the following options: **Center**, **Point 1**, **Point 2**, **Point 3** and **Point 4**.

The **Composite Options menu** enables you to control the compositing of effects onto the layer and allow you to create mattes and keys. Matte options place the effect result onto the image according to the specified matte command. Key options use the effect result as a reference object to “key on” and create a transparency in the layer. The choices include: **Blur**, **Inverse Blur**, **Matte Blur**, **Matte Inverse Blur**, **Key Blur**, and **Key Inverse Blur**.

**Blend with Original** controls the transparency of the original layer without removing the effect result. As the value approaches 0%, the original layer fades out.
**FE Spot Feather**

The **FE Spot Feather** filter allows you to define a spot on a layer and to feather the edges of that spot. You have precise control over the spot properties, including shape, position, and border width.

![Unfiltered Image](Unfiltered.jpg) ![Filtered Image](Filtered.jpg)

The **Spot Shape menu** specifies the shape of the feathered area. Choose from the following options: **Triangle, Quadrilateral, Ellipse, Circle, Rectangle,** and **Parallelogram**.

Use **Position 1, 2, 3, 4** to specify one of four control points to apply feathering. The control points determine the orientation of the grid and the amount of feathering. Manipulate the control points with the mouse or with the point picker fields in the panel. For ellipse and triangle shapes, **Position 4** is not used. For circle shapes, **Position 3 and 4** are not used.

**Border Width** determines the amount of the border around the feathered area.

The **Border Position menu** helps locate a spot on an image, and defines how the border is place relative to the spot boundary. The choices are: **Inside, Centered,** and **Outside**.

The **Spot Angle** controls the orientation of the spot.

The **Rotate About menu** determines the point around which the feathered area rotates. Choose from the following options. The choices include: **Center, Point 1, Point 2, Point 3,** and **Point 4**.

**Corner Rounding** controls the rounding of square corners when you apply the triangle, quadrilateral, rectangle, or parallelogram spot shapes.

The **Composite Options menu** allows you to control the compositing of effects onto the layer and allow you to create mattes and keys. Matte options place the effect result onto the image according to the specified matte command. Key options use the effect result as a reference object to “key on” and create a transparency in the layer. The choices are **Matte Spot** and **Matte Inverse Spot**.

**Blend with Original** controls the transparency of the original layer without removing the effect result. As the value approaches 0%, the original layer fades out.
FE Spot Frame

The **FE Spot Frame** filter defines a spot on a layer and composites a frame around the edges of that spot.

The **Spot Shape menu** specifies the shape of the feathered area. Choose from the following options: *Triangle, Quadrilateral, Ellipse, Circle, Rectangle, and Parallelogram.*

**Position 1, 2, 3, 4** specifies one of four control points to apply feathering. The control points determine the orientation of the grid and the amount of feathering. You manipulate the control points with the mouse or with the point picker fields in the panel. For ellipse and triangle shapes, Position 4 is not used. For circle shapes, Position 3 and 4 are not used.

The **Frame Style menu** specifies the number of bevels. The choices are *Single or Double.*

**Frame Width** specifies the width, or thickness, of the frame.

**Frame Color** specifies the color of the frame.

**Frame Opacity** controls the opacity of the frame.

**Light Angle** controls the beveled look of the frame by manipulating the angle of the light.

**Light Color** specifies the beveled light color. A color palette is provided.

**Light Intensity** controls the intensity of the beveled light.

**Frame Angle** specifies the angle, or direction, of the frame.

The **Rotate About menu** specifies the point around which the feathered area rotates. The choices include: *Center, Point 1, Point 2, Point 3, and Point 4.*

The **Frame Keying Options menu** controls which section of the layer to key out. The process of keying causes the underlying image to be transparent in specified area. The choices are: *None, Key Frame, Key Inside, Key Outside, and Key Outside & Inside.*

**Corner Rounding** controls the rounding of square corners when you apply the triangle, quadrilateral, rectangle, or parallelogram spot shapes.
FE Spot Tatter

The FE Spot Tatter filter allows you to define a spot on the layer and place a tattered edge around the spot. You have precise animation control over the spot properties, including shape, position, and border width.

When working with the Circle and Ellipse spots, use the Snap to Cycle control to force a whole number of tatter cycles. This provides an easy way to make a more continuous tatter pattern.

The Spot Shape menu specifies the shape of the feathered area. Choose from the following options: Triangle, Quadrilateral, Ellipse, Circle, Rectangle, and Parallelogram.

Position 1, 2, 3, 4 specifies one of four control points to apply feathering. The control points determine the orientation of the grid and the amount of feathering. You manipulate the control points with the mouse or with the Position 1 through 4 point picker fields in the panel. For ellipse and triangle shapes, Position 4 is not used. For circle shapes, Position 3 and 4 are not used.

Border Width specifies the amount of the border around the feathered area.

The Border Position menu helps locate a spot on an image, and defines how the border is placed relative to the spot boundary. The choices are Inside, Centered, and Outside.

Spot Angle controls the orientation of the spot.

The Rotate About menu specifies the point around which the feathered area rotates. The choices include: Center, Point 1, Point 2, Point 3, and Point 4.

The Composite Options menu enables you to control the compositing of effects onto the layer and allows you to create mattes and keys. Matte options place the effect result onto the image according to the specified matte command. Key options use the effect result as a reference object to “key on” and create a transparency in the layer. Choose from Matte Spot or Matte Inverse Spot.

Edge Color specifies the color outside the layer edge.
Edge Color Amp specifies the strength of the edge color. An amplitude of 0 results in no visible edge color.

The Tatter Style menu specifies a tattering style for the edge. Choose from the following options: Frame, Sawtooth, Scallop, InvScallop, Sinusoid, Brick, Frieze, JaggedEdge, Rip, Tear, Shred, Perforate, Rugged, Curey, Brushstroke, Noisy 1, and Noisy 2.

Tatter Amplitude specifies the size, or height, of the tatters. At 0, both the tatter and the edge color disappear.

Tatter Stretch specifies the stretch of the tatters.

With Snap to Cycle, if you activate the Ellipse/Circle checkbox, it forces a whole number of tatter cycles.

Tatter Skew specifies the direction to skew the tatter.

Tatter Phase specifies the phase of the tatter function, which causes the tatter to flow around the spot boundary.

Blend with Original controls the transparency of the original layer without removing the effect result. As the value approaches 0%, the original layer fades out.
**FE Spot Turbulence**

The **FE Spot Turbulence** filter simulates turbulent fluid flow, like jet aircraft exhaust or heat waves above fire. Using the FE Spot Turbulence filter creates vortices that you control in a number of different ways. You can localize the turbulence to a particular area of the image with a “spot” control.

- **Complexity** sets the number of vortices.
- **Distortion Amplitude** controls the amount of distortion.
- **Vortex Size** controls the radius of the vortices.
- **Direction** sets the direction of the vortices.
- **Direction Spread** spreads the vortices out along the Direction axis. Ranges from 0 to 360 degrees.
- **Speed** sets the speed of the vortices.
- The **Spot Shape menu** specifies the shape of the feathered area. Choose from the following options: Triangle, Quadrilateral, Ellipse, Circle, Rectangle, and Parallelogram.
- **Position 1, 2, 3, 4** specifies one of four control points to apply feathering. The control points determine the orientation of the grid and the amount of feathering. You manipulate the control points with the mouse or with the Position 1 through 4 point picker fields in the panel. For ellipse and triangle shapes, Position 4 is not used. For circle shapes, Position 3 and 4 are not used.
- **Border Width** specifies the amount of the border around the feathered area.
- **Invert Spot** inverts the spot area.
- **Seed** changes the result of the random number generation and the result of the turbulence. Ranges from 1 to 32767.
FE Wiggle Edges

The FE Wiggle Edges filter places self-animating wiggly lines on the edge of the alpha channel of the layer.

![Unfiltered Image](image1) ![Filtered Image](image2)

Amplitude specifies the size, or height, of the wiggle.

Width specifies the thickness of the wiggle line.

Frequency controls the number of wiggles.

Edge Offset specifies the position of wiggles relative to the alpha edge.

Edge Sensitivity specifies how closely the wiggles follow the details of the alpha edge.

Edge Offset and Edge Sensitivity work in conjunction with each other to control the way the wiggles move on and off the alpha edge.

Center Color specifies the color of the center of the wiggle. A color palette is provided.

Outer Color specifies the color of the edge of the wiggle. A color palette is provided.

Center Color Opacity specifies the opacity, or density, of the center of the wiggle.

Outer Color Opacity specifies the opacity, or density, of the edge of the wiggle.

The Composite Options menu enables you to control the compositing of effects onto the layer and allow you to create mattes and keys. Matte options place the effect result onto the image according to the specified matte command. Key options use the effect result as a reference object to “key on” and create a transparency in the layer. Choose from On Top or Behind.
The **Transfer Mode menu** controls how the effect blends or reacts with the applicable layer. The choices include: *Normal, Add, Subtract T from B, Subtract B from T, Difference, Multiply, AND, OR, XOR, Maximum, Minimum, Lighten, Darken, Screen, Overlay, Soft Light, Hard Light, Dissolve, Dancing Dissolve, Soft Dissolve, Dancing Soft Dissolve, Hue, Saturation, Color, and Luminosity*.

The **Line Key Options menu** specifies how to apply the key to the line. The choices are *None, Key on Line, and Key on Inverse Line*.

The **Area Key Options menu** specifies how to apply the key to the area around the line. The choices are: *None, Inside, or Outside*.

The **Area Fill Options menu** specifies how the area is filled. The choices are: *None, Inside, or Outside*.

If you select *Inside*, the area fills with the Center Color. If you select *Outside*, the area fills with the Outside Color.

The **Layer Border Options menu** enables you to define the RGBA area outside an original layer border. The choices include: *Repeat, Mirror, Transparent, and Opaque*.

**Speed (Hz)** specifies the rate of change of the wiggle or wiggle pattern.

**Wiggle Freeze (sec)** specifies the amount of time the wiggle freezes.

The **Wiggle Cycle menu** specifies the wiggle pattern. Choose either *Repeat or Randomize*.

**Blend with Original** controls the transparency of the original layer without removing the effect result. As the value approaches 0%, the original layer fades out.
Chapter 6
Image Effects

Introduction ................................................................. 98
FE Channel Noise ...................................................... 99
FE Alpha Map .......................................................... 100
FE Composite ........................................................... 101
FE Simple Wire Removal ............................................ 102
FE Median ................................................................. 103
FE Min/Max .............................................................. 104
FE Noise ................................................................. 105
Introduction

This chapter describes the FE Image effects. Image effects allow you to alter your source footage with effects such as Noise, Min/Max and Simple Wire Removal.
FE Channel Noise

FE Channel Noise randomly adds noise to the red, green, blue, and alpha channels of your image.

Unfiltered Image  Filtered Image

The Noise menu allows you to individually control the amount of noise added to each channel. The choices are Red, Green, Blue, and Alpha.

Seed ensures that you do not generate the same noise pattern the next time you apply the effect if you seed the effect with a different number. Seed ranges from 0 to 10000. You only need to use this control if the noise effect is applied to the clip more than once.

Channel Noise changes the Red, Green, and Blue values of the noise effect pixels randomly, when enabled.

Clipping determines whether the noise causes pixel colors to wrap around when it reaches its maximum value. Each pixel has a value of 0 to 255. When the color of a pixel gets to 255, clipping occurs to make it stay at that value.

With clipping disabled, noise lets the color value wrap around, or start again at low values. When enabled, even 100% noise leaves a recognizable image. For a completely randomized image, turn off Clipping and turn on Color Noise.

Blend with Original controls the transparency of the original layer without removing the effect result. As the value approaches 0%, the original layer fades out.
FE Alpha Map

The FE Alpha Map enhances the effectiveness of other alpha channel-based effects by allowing you to perform a variety of alpha channel manipulations.

To create truly unique effects, add a blur to an alpha channel before or after using the FE Alpha Map. Click the custom UI button to access the FE Alpha Map dialog box.

The Alpha Map menu lists all the available FE Alpha Map presets. The choices are Triangular, Smooth, and Custom.

Output Level depicts the current levels in use (range of 0 to 255). Click-drag the area to create custom levels for use by the Alpha Map plug-in.
**FE Composite**

FE Composite allows you to composite an effect image and its source in different ways. FE Composite can only be used in conjunction with another effect that is applied to an image first.

![Unfiltered Image](Image1) ![Filtered Image](Image2)

**Opacity** controls the opacity of the original image. It ranges from 0 to 100%, where 100% is completely opaque.

The Transfer Mode menu lets you choose from among a number of compositing methods. The choices include: **Behind, In Front, Dissolve, Add, Multiply, Screen, Overlay, Soft Light, Hard Light, Darken, Lighten, Difference, Hue, Saturation, Color, Luminosity, Alpha Mask, Luma Mask, Inverse Alpha Mask, Inverse Luma Mask, Add Premultiplied, and Add Alpha**.

The **Channel Option** activates the **Transfer Alpha checkbox** if you want the alpha from the source effect in the composite.
FE Simple Wire Removal

FE Simple Wire Removal is a useful effect for taking out the wires used in special effects photography, like go-motion. This effect uses advanced algorithms to replace the wire with the background imagery. If the layer has several wires, you can apply the effect multiple times.

**Unfiltered Image**  **Filtered Image**

Point A and Point B mark the start and end of the wire removal path.

The Removal Style menu specifies the method used for removing the wires.

- Choose **Fade** to clear a path through the layer. The background appears through the remover.
- Choose **Frame Offset** to bring in pixel data from a previous or subsequent frame.
- Choose **Displace** to bring in pixel data from outside the remover. This interpolated pixel data replaces the wire.
- **Displace Horizontal** uses the displace technique, but constrains its background sampling to the horizontal, and is therefore useful for removing vertical wires.

**Thickness** sets the width of the removal path. For best results, the thickness should be only as wide as necessary to completely remove the wire.

**Slope** controls the softness of the remover path edge. With a small slope, the transition into the remover path is gradual. When the slope increases, the edges become abrupt.

**Mirror Blending** adjusts the pixel-replacement technique used in Displacement (Removal Style). Ranges from 0 to 100%. The default is 50%.

**Frames to Offset** lets you identify the frame to be used for the Frame Offset (Removal Style) pixel-replacement technique.
FE Median

FE Median softens the footage by discarding extreme pixel values. Each pixel is replaced by the median RGB values of adjacent pixels within a given radius. It is effective at removing small image flaws such as those due to dust particles or film scratches and at higher values can create abstract painterly looks.

The Channels menu allows you to select the channel or combination of channels to which to apply the effect. The choices are: RGBA, RGB, Red, Green, Blue, and Alpha channels.

Link Vertical controls whether or not the vertical Median amount is linked to the horizontal Median amount. Activate the checkbox to link the horizontal and vertical amounts.

Horizontal controls the horizontal amount of softening.

Vertical controls the vertical amount of softening.

Blend with Original controls the transparency of the original layer without removing the effect result. As the value approaches 0%, the original layer fades out.
FE Min/Max

FE Min/Max assigns each pixel in your footage the minimum or maximum pixel value found within a specified radius. For example, a white solid layer with a square mask shrinks one pixel on each side using minimum and a radius of one. The layer quality setting does not affect this filter.

The **Channels menu** allows you to select the channel or combination of channels to which to apply the effect. The choices are: RGBA, RGB, Red, Green, Blue, and Alpha channels.

The **Operation menu** designates the operation to perform.

- **Minimum** replaces a pixel with the smallest pixel value specified with the Horizontal and Vertical Radii.
- **Maximum** replaces a pixel with the largest pixel value specified with the Horizontal and Vertical Radii.
- **Minimum Then Maximum** performs the Minimum operation on the layer followed by the Maximum operation using the Horizontal and Vertical Radius settings.
- **Maximum Then Minimum** performs the Maximum operation on the layer followed by the Minimum operation using the Horizontal and Vertical Radius settings.

**Link Vertical** links the Vertical Radius to the horizontal Radius. Activate the checkbox to link the horizontal and vertical amounts.

The **Horizontal and Vertical Radius** specify how many pixels to examine for the Minimum or Maximum operation.
FE Noise

FE Noise randomly changes pixel values throughout the image. Adding noise creates a sensation of graininess, which obscures fine details.

The Channels menu determines which channel or channels to which the blur effect is applied.

- **Section 1** applies noise to the HLS values of your footage. The choices are HLS, Hue, Lightness, and Saturation.
- **Section 2** applies noise to the YIQ channels of the NTSC chrominance and luminance color space.
  - Luminance applies noise to the Luminance channel (Y).
  - Chroma applies noise to the Chroma channels (I and Q).
  - In Phase Chrominance applies noise to the In Phase Chrominance channel (I).
  - Quadrature Chrominance applies noise to the Quadrature Chrominance channel (Q).
- **Section 3** designates separate noise amounts in these respective channels. The choices include: RGBA, RGB, Red, Green, Blue, and Alpha channel.

Amount of Noise controls the amount of noise added to the footage.

Seed creates a different noise pattern the next time you apply the effect.

Channel Noise changes the Red, Green, and Blue values of the effect pixels randomly.

Clipping determines whether the noise causes pixel colors to wrap around when it reaches its maximum value. When the color of a pixel reaches 255, clipping occurs to make it stay at that value. With clipping deactivated, noise lets the color value wrap around, or start again at low values.

Blend with Original controls the transparency of the original layer without removing the effect result. As the value approaches 0%, the original layer fades out.
Chapter 7
Light Effects

Introduction ....................................................... 108
FE Light Burst 2.5 .............................................. 109
FE Light Rays ..................................................... 110
FE Light Sweep ................................................ 111
FE Spot Light (w/Gel Layer) .................................. 112
FE LightBlast ..................................................... 114
FE Light Tornado ............................................... 116
FE LightWhirl ................................................... 118
Introduction

This chapter describes the FE Light effects. Each effect description includes a figure of the effect editor panel and descriptions of the controls.
**FE Light Burst 2.5**

FE Light Burst 2.5 creates an effect that looks like the image is exploding with light. This effect works best on a layer with an alpha channel.

![Unfiltered Image](image1.png) ![Filtered Image](image2.png)

**Source Position** controls the X and Y position of the light source.

**Light Factor** sets the intensity of the light source.

**Ray Length** sets the length of the light rays.

The **Burst menu** sets the type of effect.

- Choose **Straight** for constant rays.
- Choose the **Fade** option to fade the rays out toward their end point.
- **Center** gives the effect of zooming in as the rays fade toward the center.

**Halo Alpha** casts the light rays through the silhouette of the alpha channel. When deactivated, the alpha layer acts as a light gel.

**Replace Colors** assigns the light rays the color you select.

**Color** sets a color for the light. A color palette and eyedropper are provided.
FE Light Rays

FE Light Rays creates radiating streaks of light. A typical use of this effect is to overlay light rays on a background and create rays of light streaking through an image.

Unfiltered Image  Filtered Image

The Shape menu lets you choose between light source shapes. The choices are Radial and Rectangular.

Radius sets the size of the light source. This affects how far the light rays reach.

Center lets you position the light source in the Composition.

Direction rotates the light. This only affects the image when the Shape is Rectangular.

Intensity sets the brightness of the light. This affects how far the light rays reach.

Color sets the color of the light. Use the color palette or eyedropper tool to set the color. Activate the Color from Source check box to pull a color from the source image.

Center Area controls the spread of rays.
**FE Light Sweep**

FE Light Sweep creates a beam of light. You can animate the beam to sweep across the image, like a searchlight cutting through a hazy night.

**Light Center** sets the reference position for the light beam.

**Light Angle** sets the angle of the beam. Animate this parameter to sweep the light back and forth.

The **Light Cone menu** sets how the light beam fades to its edge. The choices are *Linear, Smooth, and Sharp*.

**Cone Width** sets the width of the beam.

**Sweep Intensity** sets the strength of the light beam.

**Edge Intensity** controls the amount of embossing at the edges of the alpha channel.

**Light Color** sets the color for the light. A color palette and eyedropper are provided.

The **Light Reception menu** sets how the light beam interacts with the source image.

- **Composite** overlays the light beam on the image.
- **Add** adds the light beam to the source image.
- **Cutout** obliterates the source layer so only the light beam is visible.
FE Spot Light (w/Gel Layer)

FE Spot Light creates the illusion of a spotlight shining down on the source image. FE Spot Light (w/Gel Layer) is a dual-input effect. For example, the Gel Layer lets you use the spotlight like a slide projector, projecting the light from one image onto another.

Unfiltered Image  Filtered Image

From and To set the light direction. From defines the X and Y position of the light source. To specifies the center of the light beam on the target object.

Height sets the distance between the virtual spotlight and the source layer.

Cone Angle defines the spread angle of the spotlight beam.

Edge Softness controls the feathering at the edge of the spotlight beam. Lower values create sharper edges. Higher values create softer edges.

Color sets the color of the light. A color palette and eyedropper are provided.

Intensity sets the brightness of the spotlight.

The Render menu lets you choose how the spotlight renders.

• Choose Light Only to clear the source image and render the spotlight only.
• Choose Light Add to render the spotlight on top of the source image. This is the default choice.
• Choose Light Add+ to render the spotlight on top of the source image. Uses the source image alpha channel to determine the shape of the light, creating a stencil effect.
• Choose Light Shadow to place the source image in shadow, strengthening the spotlight effect.
• Choose *Gel Only* to clear the source image and renders just the spotlight using the selected layer as a gel. This creates a slide projector effect.

• Choose *Gel Add* to render the selected Gel Layer projected onto the source image.

• Choose *Gel Add+* to render the selected Gel Layer projected onto the source image. Gel Add+ uses the alpha channel of the Gel Layer to create a stencil of the Gel Layer image.

• Choose *Gel Shadow* to put the source image in shadow and projects the spotlight through the selected Gel Layer.

**Gel Layer** allows you to choose a layer to apply the effect.
FE LightBlast

FE LightBlast simulates rays of light. The light rays are determined by a layer matte or its colors.

Light Position sets the center point to be affected by FE LightBlast.

Light Strength controls the intensity of the light source.

Light Focus controls the spotlight effect of the light, determining the amount of light. A value of 0 causes an infinite spotlight. A value of 100% causes the light to come to a point.

Ray Length controls the length of the light rays. Positive values blast the glow toward the viewer. Negative values blast the glow away from the viewer.

Ray Falloff controls how quickly the light falls off along the ray arc. A value of 0 causes the rays to continue at the same strength to the maximum arc. When the Halo Alpha checkbox is enabled, higher Ray Falloff values create finely tapered rays of light, while lower Ray Falloff values create an outline of the image.

Haloing controls which part of the image is used for transparency. If the Halo Alpha checkbox is deselected, the image is used as the transparency. If the Halo Alpha checkbox is selected, the edges of the Alpha Channel are used, like a light gel, as the transparency for the light.

Threshold ranges from 0 to 255 levels of luminance. It specifies that the effect is to be applied to colors whose luminance values are higher than this threshold value. Any color whose luminance is below this value does not generate the light whirl.
The **Blast menu** specifies if the image is to be whirled.

- **Source** whirls the image.
- **Colorize** erases the image and replaces it with the light source, taking the color of the rays from the Color control.

**Color** sets the color of the imaginary light source and works with the Colorize control of Whirl. A color palette and eyedropper are provided.

The **Antialiasing checkbox** creates a smoother blending between the filtered layer and any background layers or objects.
**FE Light Tornado**

FE Light Tornado combines FE LightBlast and FE LightWhirl to create circular arcs of light and provides control over the rays of light.

*Unfiltered Image*  
*Filtered Image*

**Light Position** sets the center point to be affected by FE LightTornado.

**Light Strength** controls the intensity of the light.

**Light Focus** controls the spotlight effect of the light. A value of 0% causes an infinite spotlight. A value of 100% causes the light to come to a point.

**Ray Length** controls the length of the light rays. Positive values blast the glow toward the viewer. Negative values blast the glow away from the viewer.

**Ray Arc** controls the angle of the light twirl.

**Ray Falloff** controls how quickly the light falls off along the ray arc. A value of 0 causes the rays to continue at the same strength to the maximum arc.

If the **Halo Alpha checkbox** is deselected, the image is used as the transparency. If the checkbox is selected, the edges of the Alpha Channel are used, like a light gel, as the transparency for the light.

**Threshold** specifies that the effect is applied to colors with luminance values higher than this threshold value. Any color with luminance below this value does not generate the light whirl. The range is from 0 to 255 levels of luminance.
The **Tornado menu** specifies if the image is to be whirled.

- **Source** whirs the image.
- **Colorize** erases the image and replaces it with the light source, taking the color of the rays from the Color control.

**Color** sets the color of the imaginary light source. A color palette and eyedropper are provided.

**Antialiasing** creates a smoother blending between the layer to which you apply it and any background layers or objects.
FE LightWhirl

FE LightWhirl works on the same principle as FE LightBlast, but instead creates circular arcs of light.

Light Position sets the center point to be affected by FE LightWhirl.

Light Strength controls the intensity of the light.

Light Focus controls the spotlight effect of the light. A value of 0% causes an infinite spotlight. A value of 100% causes the light to come to a point.

Ray Arc controls the angle of the twirl. The range is from -360 to 360 degrees.

Ray Falloff controls how quickly the light falls off along the ray arc. A value of 0% causes the rays to continue at the same strength to the maximum arc. A value of 100% returns the original image modified with the light source.

Haloing controls which part of the image to use for the transparency. If the Halo Matte checkbox is deselected, the image is used as the transparency. If the checkbox is selected, the edges of the matte are used, like a light gel, as the transparency for the light.

Threshold specifies that the effect is to be applied to colors with luminance values higher than this threshold value. Any color with luminance below this value does not generate the light whirl. The range is from 0 to 255 levels of brightness.

The Whirl menu specifies whether to whirl the image. Options include:

• Source blasts the image.
• Colorize completely erases the image and replaces it with the light source, taking the color of the rays from the Color control.

Color sets the color of the imaginary light source. It works with the Whirl Colorize option.

Antialiasing creates a smoother blending between the layer to which you apply it and any background layers or objects.
Chapter 8
Particle Effects

Introduction ................................................................. 120
FE Ball Action ............................................................ 121
FE Bubbles ................................................................. 123
FE Drizzle ................................................................. 124
FE Hair (w/Hairfall Map) .............................................. 125
FE Mr. Mercury ......................................................... 127
FE Particle System II .................................................. 130
FE Particle World ....................................................... 134
   Working with the Additional Options ....................... 139
FE Pixel Polly ............................................................ 143
FE Rain ................................................................. 145
FE Snow ................................................................. 146
FE Star Burst ........................................................... 147
Introduction

This chapter describes the FE Particle effects category. In the descriptions, sizes and distances are measured in pixels. Some panels provide expansion buttons that toggle to reveal additional controls.
FE Ball Action

**FE Ball Action** transforms an image into balls. You can rotate and twist the balls around a specified axis and scatter them in all directions. For After Effects users, this filter supports the comp camera, which lets you move the camera around the array. Only completely opaque pixels are transformed into balls.

Unfiltered Image  Filtered Image

**Scatter** sets the intensity of the scatter effect. The higher the value, the further the balls scatter.

The **Rotation Axis menu** sets the rotation axis to use.

- **X, Y, or Z** rotates the balls around the one chosen axis.
- **XY, XZ, or YZ** rotates the balls around the two different axes.
- **XYZ** rotates the balls on all three axes.
- **X15Z Axis** rotates the balls 15 times round the Z axis for every one rotation around the X axis. The effect is a whorl, similar to a rotating galaxy. These settings are very sensitive.
- **XY15Z Axis** rotates the balls 15 times around the Z axis for every rotation around both the X and Y axes. These settings are very sensitive.

**Rotation** rotates the array of balls around the axis chosen with the **Rotation Axis menu** setting. The array can rotate any number of degrees and revolutions, using positive or negative direction. For example, setting 15 rotations rotates the balls 15 times over the length of your animation.

The **Twist Property menu** sets the type of Twist that is applied. Twist is a rotation offset that is applied to the balls using the chosen Twist Property. This choice determines how the balls twist when using the **Twist Angle** parameter. Choose from the following options.

- **X Axis** and **Y Axis** twist the balls around the chosen axis.
- **Center X** and **Center Y** starts the twist at the center point of the chosen axis.
• **Radius** focuses the greatest twisting in the center of the image. Twisting diminishes as it moves toward the periphery.

• **Random** creates a chaotic twist.

• **Red, Green, and Blue** base the twist on the intensity of the chosen color channel. Least intense areas twist the most.

• **Brightness** bases the twist on the brightness of the image. The darkest portion twists the most.

• **Diamond** twists the image into a diamond.

• **Rectangle** twists the images into a rectangle.

• **Fast Top** twists both the X and Y axis, with the Y axis twisting faster than the X axis.

**Twist Angle** applies twist to the array, based on the Twist Property menu setting. The array of balls can twist any number of degrees and revolutions, using positive or negative direction.

**Grid Spacing** controls the density of the balls by setting the size of the grid. Higher values make the grid resolution greater, generating a larger number of smaller balls; while lower values generate a smaller number of larger balls. As the number of balls increases, the size of each individual ball decreases. This control has an extended range.

Rendering time is directly proportional to the number of balls in the effect. If you use a high value, you might want to work in Draft mode to avoid long preview times.

**Ball Size** sets the size of the ball particles. The ball size is relative to the Grid Spacing value. This means that you can make the balls smaller or larger than the cells where they reside. When balls are smaller, empty cell areas are transparent. When balls are larger, cells are completely filled to the extent that they start overlapping each other. This control has extended range.

Use the **Antialiasing menu** to maximize the quality and/or minimize the render time and memory requirement of custom ball effects. **High** creates a smoother blending between the layer to which you apply it and any background layers or objects. **Low** minimizes render and preview times.

**Instability State** controls the individual rotation of each ball, which is also affected by the amount of scatter. Scatter must have a non-zero value for this parameter to have any affect. Instability State can be any number of degrees and revolutions, using either positive or negative directions.
**FE Bubbles**

FE Bubbles creates a bubble effect in the selected layer.

![Unfiltered Image](image1) ![Filtered Image](image2)

**Bubble Amount** sets the number of bubbles to use in the effect. The number of bubbles that appear in the effect may not correspond to the number that actually appears in the image.

**Bubble Speed** controls the speed of bubble movement. A positive speed value makes the bubbles rise. A negative value makes the bubbles fall.

**Amplitude** controls the amount of side-to-side shimming added to the bubbles while rising or falling. The higher the value, the more bubbles move sideways from their original path, at the frequency determined by the **Frequency** parameter.

**Frequency** sets the frequency at which bubbles wobble. The higher the value, the faster bubbles move from side-to-side, using the amplitude determined by the Amplitude parameter.

**Bubble Size** controls the overall size of the bubbles.

The **Reflection Type menu** sets the type of reflection.

- **Inverse Reflection** gives the bubbles self-contained reflections, as if each bubble was reflecting itself.
- **World Reflection** makes the bubbles reflect the source image.

The **Shading Type menu** defines the type of shading to use for the bubbles.

- When **None** is chosen, no shading is applied to the bubble.
- **Lighten** fades to white at the edges of the bubble.
- **Darken** fades to black at the edge of the bubble.
- **Fade Inwards** makes the center of the bubble transparent similar to soap bubbles.
- **Fade Outwards** makes the edges of the bubbles transparent. For a smoky effect, use Fade Outward with a very high number of bubbles.
**FE Drizzle**

As a particle generator, **FE Drizzle** creates circular distortions that look like raindrops disturbing the reflection in a pond as ringlets appear and spread out over time.

*Unfiltered Image*  
*Filtered Image*

**Birth Rate** controls how quickly ripples are created. A low setting creates ripples few and far between. Increase the Birth Rate to produce more ripples.

**Longevity (secs)** sets the ripple duration. From birth, each ripple expands to its full radius over the course of the Longevity setting. The radius is determined by the **Ripple Radius Growth** parameter. The higher the Longevity setting, the slower ripples expand to their full radius. Longevity cannot be animated.

**Rippling** sets the number of rings in each ripple. Each time around the dial adds another ring. For example, at a value of 1080, three rings are created (3 x 360 degrees = 1080 degrees.)

**Displacement** sets how much the ripple distort the image.

**Ripple Height** sets the appearance of height in the ripple. The height affects the displacement as well as the shaded appearance.

**Ripple Radius Growth** sets the size to which the ripple expands.
FE Hair (w/Hairfall Map)

FE Hair creates particles that stretch into filaments like hair. Hair uses a chosen property to determine where hair should grow.

This effect uses the Alpha Channel to determine where hair should grow. With no mask, hair grows everywhere. Before using FE Hair, add a matte layer to define the region that generates hair. The Hair layer is above the layer containing the image wearing the hair.

The FE Hair (w/Hairfall Map) is a dual-input effect. Use this effect to input another clip to control how the hair falls. Use a map to get some hair to droop and other hair to stand up more. The Hairfall Map modulates the Gravity setting.

Hairfall Map sets the layer that control how the hair falls. A height map is created from this layer, using the values defined by Base Hairfall On menu. A height map has ridges and crests. An up or downwards slope creates a hair growth direction away from the viewer. A flat surface creates a direction straight towards the viewer (out from the layer). For example, a radial ramp from bright center to dark rim creates as a cone, seen from the top, with hairs pointing straight out from the cone’s surface. Experimenting with maps and using masks improves the hair’s appearance.

The Base Hairfall On menu lets you choose which channel information from the selected Hairfall Map image controls the hairfall. Choose from Alpha, Red, Green, Blue, Lightness and Luminance.

Map Smoothness controls the softness or blurring of the hair fall map. Increasing softness removes small details from the map layer, making the hair fall more uniformly.

Map Post-Noise applies noise to the hair fall map to add randomness to the hair fall. This control is applied after Map Smoothness. This allows you to soften a map to create more uniform hair fall, then slightly increase randomness again by adding noise. Balancing the values of these two parameters adds more control over the hair fall.

Length sets how long the hair grows. Length and Thickness also affect the relative Weight.

Thickness sets the diameter of the individual hairs.
Weight sets the relative weight of the hair. A higher Weight setting increases the hair’s tendency to droop, as if it were wet. Weight is also affected by the Length and Thickness values. Animate this control to add bounce to the hair.

Spreading controls the simulated Z-depth of the hair fall map. Increasing the extrude value increases the simulation of depth.

Density sets the density of hair follicles, from which hair grows, over the selected Map Layer. Lower values create fewer follicles, resulting in sparse hair growth. Higher values create more follicles, resulting in dense hair growth.

Hair Color sets the color for the hair. You can use the Color Inheritance parameter to create variety into the hair color. A color palette and eyedropper are provided.

Color Inheritance determines the color of the hair using the layer pixel where the hair starts to grow to set the color. At a Color Inheritance value of 100, color comes entirely from the layer pixels. Lower settings mix the chosen hair Color with the inherited color.

Opacity sets the transparency of the hair strands, expressed as a percentage. At a value of 0, hair is totally transparent. Reducing opacity allows the background to show through and is useful at high Density and low Thickness values.

Light Angle controls the direction of the light. The appearance of the hair changes as the light moves. Generally, you should set Light Angle to match the lighting in the other layers of your composition.

The five lighting controls work together with the Roughness parameter to create the sense of depth and texture in the hair.

Light Height sets the distance from the source image to light source, based on Z coordinates. Negative values move the light source behind the source layer, with the result that light rays strike the layer from behind, or from below.

Ambient controls the amount of ambient (nondirectional) light on the hair. Reduce Ambient light to strengthen the depth and texture of the hair.

Diffuse controls the amount of direct light on the hair, which increases the 3D appearance of the hair. Diffuse light affects all visible surfaces directly illuminated by light.

Specular controls the highlight in the hair. Increasing the Specular setting creates bright shiny hairs where the light reflects directly on the hair. Shiny materials, like chrome, have strong highlights while matte materials, like rubber, have weak highlights. As you increase the Specular value, a specular highlight appears in the center of the diffuse areas where the light reflects directly on the image.

Roughness controls the spread of the specular highlight. Low roughness produces a small bright highlight. Higher Roughness values make the highlight larger and less shiny.
**FE Mr. Mercury**

**FE Mr. Mercury** is a particle system that creates ever-changing blobs rather than stable shapes. You can use Mr. Mercury controls to create an almost infinite number of different animations. Mr. Mercury is especially adept at creating convincing mercurial effects for like cascading water, molten metal, and dissolving plastic.

The blobs created by Mr. Mercury behave realistically, splitting and rejoining just like real-world liquid particles. The source image is used as a reflection map for the particles. Almost all controls are animated dynamically, and Mr. Mercury fully supports time remapping. As with all particle systems, you may need to move ahead a little bit in the timeline before you really see the blobs.

**X Radius** and **Y Radius** set the size of the producer in the X and Y coordinates, respectively. For example, if Radius X has twice the value of Radius Y, the result is an oblong blob whose width is twice that of its height.

**Producer** sets the center point of the blob producer on the layer where blobs are emitting, based on X and Y coordinates. Producer also serves as the anchor point for the Direction parameter.

**Direction** determines the direction of the blob flow.

**Velocity** sets the speed of blobs at birth. The higher the setting, the faster the blobs move. Once ejected from the producer, the speed and direction of the blobs are determined largely by Gravity and other natural forces such as Resistance. Negative settings reverse the direction of the blobs.

**Birth Rate** controls the number of blobs born at any given point in time. The higher the Birth Rate, the greater the density of blobs. Using very high values can increase rendering times.

**Longevity (secs)** sets the life span of the blobs. The higher the Longevity setting, the longer the blobs exist. Longevity is the sole Mr. Mercury parameter that cannot be animated.
Gravity applies a secondary force to the particles' movement as they flow from the source. Gravity can either counteract or strengthen the blobs' initial Velocity. Positive values draw the blobs down while negative values let them rise.

Resistance applies constant friction, which slows the blobs initial velocity and causes them to decelerate as they disperse. This parameter can be used to give blobs very convincing natural behaviors, like meeting air or moving through water. The higher the value, the more resistance blobs meet, slowing them down more quickly.

Extra sets the amount of randomness added to particles motion. The affect of the “extra” factor varies depending on the Animation System menu setting. The higher the Extra value, the greater the randomness of the particles motion. Extra affects each animation type in a different way. Some Animation System setting, such as Explosive, do not use Extra.

The Animation System menu determines the movement behavior of the blobs after birth.

- **Explosive** spreads the blobs evenly in all directions. Extra has no affect when Explosive is chosen.

- **Fractal Explosive** spreads the blobs in all directions with a pattern determined by a fractal model. Useful for creating any effect where a ragged, uneven look is desirable, such as a natural explosion. Alter the fractal model by changing the Direction parameter. Fractals are not interpolated. This means sharp transitions are created if you animate Direction.

- **Twirl** creates a single direction, rotating whirlpool with the blobs spreading evenly with the initial rotation. The Twirl is controlled by the Direction parameter. Extra determines the rotation deceleration.

- **Twirly** creates a bi-directional, rotating twirl. Blobs spread evenly with initial rotation. The Twirl is controlled by the Direction parameter. Extra sets the rotation deceleration.

- **Vortex** creates an upward rotation with accelerating width and decelerating rotation speed. The blobs rotate upwards. in this funnel-like effect. Gravity sets the width of the vortex. Direction controls the rotation speed. Extra sets the rotation speed deceleration.

- **Fire** creates a realistic fire model where the blobs oscillate while rising. Extra controls the amplitude of oscillation. Since fire burns upward, a positive Gravity value makes the blobs rise rather than fall.

- **Direction** spreads the blobs evenly in the direction set using the Direction control. Extra determines the angle of the blob nozzle from which the blobs emanate. To better understand how the blob nozzle works, set Gravity to 0, Extra to 0 and Direction to 180°, then adjust Extra using both positive and negative values.

- **Direction Normalized** is similar to Direction: the blobs spread evenly in the direction set in the Direction control, except all the blobs move at the same speed.

- **Bi-Directional** spreads the blobs evenly in both the direction set using the Direction control and in the exact opposite direction. Extra determines the angle of the blob nozzle from which the blobs emanate. To better understand how the blob nozzle works, set Gravity to 0, Extra to 0 and Direction to 180°, then adjust Extra using both positive and negative values.
• **Bi-Directional Normalized** is similar to Bi-Directional, except all the blobs move at the same speed.

• **Jet** creates blobs that inherit the producer’s movement. **Extra** adds random motion to the blobs. You must animate the **Producer** to create this effect.

• **Jet Sideways** creates blobs that inherit the producer’s velocity, but channels it into sideways motion. **Extra** adds random motion to the blobs. You must animate the **Producer** to create this effect.

**Blob Influence** determines the amount and speed at which matter from smaller blobs moves into larger blobs, as the “attraction” force generated by the blobs.

The **Influence Map menu** determines the behavior of the blobs as they appear and disappear. Choose from the following options.

• **Go Out** shrinks the blobs smoothly into nothing at the moment of death.

• When **Come In** is chosen, the blobs grow smoothly out of nothing at birth.

• When **Come in&out** is chosen, the blobs grow smoothly out of nothing at birth and shrink smoothly into nothing at death.

• When **Go out sharp** is chosen, the blobs maintain a fairly consistent size during life, but shrink sharply into nothing at death.

• When **Constant** is chosen, the blobs maintain a fairly constant size throughout their lives.

**Blob Birth Size** sets the beginning size of the blobs.

**Blob Death Size** sets the ending size of the blobs.
FE Particle System II

FE Particle System II is an auto-animated particle generator that provides in-depth control over individual particles as well as the overall shape and movement of the system. This filter allows you to independently control features such as Opacity Mapping, Color Mapping, Particle Animation and Particle Objects to create an almost infinite variety of animation effects. These animations might range from simple explosions to massive smoke screens. You can also twirl polygons in different directions, or create oscillating convex lenses.

Particle System II is especially useful when you want to animate the position and size of the particle generator. The filter can use the source layer as texture, or use the colors from the source layer as birth and death colors for the particles. Most parameters can be dynamically animated. The control values only affect the particles at the time of birth. For example, animating Birth Color will not affect the particles before birth.

X Radius and Y Radius set the size of the producer in the X and Y coordinates, respectively. For example, if Radius X has twice the value of Radius Y, the result is an oblong area whose width is twice that of its height.

Producer sets the center point of the producer on the layer where particles are emitting, based on X and Y coordinates. Producer also serves as the anchor point for the Direction parameter.

Direction determines the direction of the blob flow.

Birth Rate sets the number of particles created at any given point in time. The higher the Birth Rate, the greater the density of particles. Very high values can increase rendering time.

Longevity (sec) sets the life length of all particles. The higher the Longevity setting, the longer the particles exist. You cannot animate Longevity.

The Particle Animation menu sets the type of motion for the particles.

• Explosive spreads the particles evenly in all directions with random speed. This is useful for creating fireworks, which you can simulate by pulsing the Birth Rate between zero and a high value.
- **Fractal Explosive** spreads the particles in a pattern according to a fractal model. This is useful for creating an uneven look, for example a natural explosion. Alter the fractal model by changing the Direction parameter. Fractals are not interpolated. This means sharp transitions are created if you animate Direction.

- **Twirl** creates a whirlpool effect. The Twirl goes in one direction and the particles spread evenly. Twirl is controlled by Direction. Air Resistance sets the rotation speed deceleration.

- **Twirly** creates a random rotation twirl, with particles that spread evenly. The Twirl is controlled by Direction. Air Resistance sets the rotation speed deceleration.

- **Vortex** creates a whirling, funnel-like effect. The particles rotate upwards. Gravity controls the width of the vortex. Direction sets the rotation speed. Air Resistance controls rotation speed deceleration.

- **Fire** animates the particles to oscillate while rising. Extra controls the amplitude of oscillation. Since fire burns upward, a positive Gravity setting makes the particles rise rather than fall.

- **Direction** spreads particles evenly in the direction set in the Direction control. Turbulence defines the area covered by the effect. Extra determines the angle of the particle nozzle from which the particles emanate. To better understand how the particle nozzle works, set Gravity to 0, Extra to 0 and Direction to 180°, then adjust Extra using both positive and negative values.

- **Direction Normalized** spread the particles evenly in the direction set in the Direction control. All particles have the same speed. Extra defines the area covered by the effect.

- **Bi-Directional** spreads the particles evenly in opposite directions, set in the Direction control. Turbulence defines the area covered by the effect.

- **Bi-Directional Normalized** spreads the particles evenly in opposite directions, set in the Direction control. All particles have the same speed. Extra defines the area covered by the effect.

- When **Jet** is chosen, the particles inherit motion from the Producer’s movement. Extra adds randomness to the particle motion. You must animate the Producer to create this effect.

- When **Jet Sideways** is chosen, the particles inherit motion from the Producer’s movement, and direct it sideways. Extra adds randomness to particles motion. You must animate the Producer to create this effect.

Velocity sets the speed of particles at birth. The higher the setting, the faster the particles move. Once ejected from the producer, the speed and direction are determined largely by Gravity and other natural forces. Negative settings reverse the direction.

Gravity gives weight to the particles. Higher Gravity causes particles to fall faster. A negative setting makes particles rise.
Increasing the **Air Resistance** value adds resistance to the particles initial velocity, causing them to decelerate as they disperse. This simulates how particles are influenced by resistance from friction or a substance’s viscosity as they move. Use this parameter to give particles very convincing natural behaviors, like meeting air or moving through water. The higher the value, the more resistance particles meet, slowing them more quickly.

**Direction** sets the direction in which the particles move.

**Extra** gives the particles a more random motion. The higher the Extra setting, the greater the randomness of the particles motion. Extra affects each animation type in a different way. Some Animation types, such as **Explosive**, do not use Extra.

The **Particle Object menu** determines the shape of the particles.

- When **Pixel** is chosen, each particle is a single pixel. In motion, the pixels become lines.
- When **Antialiased Pixel** is chosen, the particles are antialiased lines.
- **Star** creates four-pointed stars.
- **Drop** creates particles that simulate drops of water.
- **Shaded Sphere** creates spheres, darkened at the edges.
- **Fades Sphere** creates spheres, faded at the edges.
- **Shaded&Faded Sphere** creates spheres, with darkened and faded edges.
- **Bubble** creates spheres, faded toward their centers.
- **Motion Polygon** creates polygons. The higher the speed, the larger the particles.
- **3D Polygon** creates 3D polygons, shaded as if the light source is the viewer’s eye. **Direction** controls the rotation speed.
- **3D Squares** creates 3D squares, shaded as if the light source is the viewer’s eye. **Direction** controls the rotation speed.
- **Cuby** creates cubes, shaded as if the light source is the viewer’s eye. **Direction** controls the rotation speed.
- **Tetrahedrons** creates tetrahedrons (a polyhedron with four faces), shaded as if the light source is the viewer’s eye.
- **FE** creates particles shaped like the letters “FE,” shaded as if the light source is the viewer’s eye.
- **Textured Poly** creates 3D polygons, shaded as if the light source is the viewer’s eye. They also take on the texture of the source layer. **Direction** controls the rotation speed.
- **Textured Square** creates 3D squares, shaded as if the light source were the viewer’s eye. They also take on the texture of the source layer. **Direction** controls the rotation speed.
- **Lens Convex** creates particles shaped like convex lenses.
- **Lens Concave** creates particles shaped like concave lenses.
- **Lens Fade** creates particles shaped like concave lenses fading toward the edges.
- **Lens Darken Fade** creates concave lenses, darkening and fading toward edges.
- **Lens Bubble** creates particles shaped like bubbly lenses, fading inward.
Max Opacity sets the highest level of opacity for the particles during their lifetime. Particle’s opacity changes over their lifetime according to the Opacity Map menu setting.

The Opacity Map menu sets an opacity map for the particles. The selected map, in conjunction with the Max Opacity control, determines the opacity changes for the particles over their lifetime.

- **Fade Out** starts the particles at the Max Opacity value then fades out the particles.
- **Fade In** starts the particles transparent then fades in the particles to the Max Opacity value.
- **Fade in&out** starts the particles transparent then fades in the particles to the Max Opacity value then fades out the particles.
- **Fade out&in** starts the particles at the Max Opacity value then fades out the particles then fades the particles back to the Max Opacity value.
- When Oscillate is chosen, the particles oscillate between Max Opacity and complete transparency.
- **Fade out fast** keeps the particles at Max Opacity until just before the end of their lifetime. Then the particles fade out fast, like sparks going out.
- **Constant** keeps particles at Max Opacity from birth to death.

Birth Color determines the color of the particles at birth. This parameter has no affect if the Color Map menu is set to Original to Death or Original to Original.

Death Color determines the color of the particles at death. This parameter has no affect if the Color Map menu is set to Birth to Original or Original to Original.

The Color Map menu defines how particle colors are interpolated from the Birth Color to the Death Color value.

- Choose Birth to Death to use the Birth Color and Death Color values chosen for color transition.
- Choose Original to Death to take the birth color from the position in the image where the particle originated. The color changes over time into the defined Death Color.
- Choose Birth to Original to start the particle with the defined Birth Color. The Death Color is taken from the original image where the particle originated.
- Choose Original to Original to take the color from the original image and retains the color throughout its lifetime.

Particle Birth Size sets the relative size of the particles at birth.

Particle Death Size sets the relative size of the particles at death.
FE Particle World

FE Particle World provides a three-dimensional environment for particle generation and animation. Particle World contains controls for particle behavior in the third dimension, for the placement and movement of a virtual camera, and provides visual guides to help you navigate through this three-dimensional environment.

Fe Particle World supports After Effect’s comp camera; the filter automatically selects an AE comp camera if present and enabled. For users of other hosts, you can alternatively place and move a virtual camera; visual guides help you navigate through this three-dimensional environment.

Realistic 3D behavior enables you to create animations that fly directly through a fiery explosion, sparkling fountain, or stream of glowing, golden coins. Almost all controls can be animated. Particle World fully supports time remapping. (Particle World does not composite with other 3D layers. As an effect, it’s limited to its own source layer.)

Working with the Scrubber Controls

The Scrubbers are indirect manipulation tools. Drag the scrubbers to change the settings of one or more of parameters. Clicking the scrubber labels (Screen, World, Radius and Camera) opens a numeric input dialog box. To reset a single Scrubber control to its default value, Command-click (Control-Shift-Click) the scrubber. Standard Shift key constraints are also available. The Control key toggles available control options.

Drag the Screen control to change the location of the Producer relative to the current camera point of view. Use the + symbol to move on the X and Y axes, and the Z to move on the Z axis.

Clicking the Options button opens a dialog box which allows you to set additional parameters including an Opacity Map, Color Map, Grid, and Rendering settings. For details, see “Working with the Additional Options” on page 139.
Drag the **World** control to change the location of the Producer based on absolute Particle World environment coordinates. Use the + symbol to move on the X and Y axes, and the Z to move on the Z axis.

Drag the **Radius** control to change the Producer radius interactively.

Drag the **Camera** globe to rotate the effect camera around the X or Y axes interactively. Drag the Z to change Camera Distance. You may need to resize the window to make this control visible. For After Effects users, the Camera scrubber area is always hidden when an AE camera is in use.

**Producer X, Producer Y, and Producer Z** define the location of the producer at a given point in time, based on X, Y, Z coordinates respectively. Positive Z values move the producer away, while negative Z values move it closer (depending on the camera position of course). Coordinates within Particle World are normalized by the source layer width and centered.

**Radius X, Radius Y, and Radius Z** set the size of the particle producer sphere, based on X, Y, Z coordinates. For example, setting only Radius Z and Radius X, the producer sphere will be • at like a pancake.

The **Animation System menu** lets you choose an animation type for the particles. Choose from the following options.

- **Explosive** spreads particles evenly in a direction with random speed. This choice is useful for creating particle bursts such as fireworks by pulsing the Birth Rate value between zero and a high value.

- **Direction Axis** spreads particles evenly in a direction controlled by Extra Angle. Extra Angle rotates the producer around the axis specified in the Direction dialog box (accessed by clicking the Options button). This results in a cone-shaped effect. The Extra control adds randomness to the direction of the particles, resulting in a cone-shaped effect.

- **Cone Axis** spreads particles evenly in a cone shape whose width is determined by the Extra Angle control. The cone shape reacts as if the Extra Angle folds an umbrella along the axis specified in the Direction dialog box (accessed by clicking the Options button). The Extra control adds randomness to the direction of the particles.

- **Viscouse** spreads the particles evenly in all directions, but the initial speed of the particles is reduced by the Extra setting. This is useful for simulating more realistic animations by including air or water resistance for the particles.

- **Twirl** creates a whirlpool-like, single-direction, rotating twirl, with the particles spreading evenly with the initial rotation. Extra sets the rotation deceleration.

- **Twirly** creates a single-direction rotating Twirl. Particles spread evenly with initial rotation. Extra adds rotation around the producer when Velocity is set very low. Extra Angle controls the rotation speed of the Twirl.

- **Vortex** creates an upward rotating, whipping, funnel-like effect with accelerating width and decelerating rotation speed. Extra Angle controls the rotation speed. Extra sets the rotation speed deceleration.
• **Fire** creates a fire model where the particles oscillate while rising. **Extra** controls the amplitude of oscillation. Since fire burns upward, a positive **Gravity** setting makes the particles rise rather than fall.

• **Jet** creates particles that inherit the producer’s movement. **Extra** adds motion to the particles. You must animate the Producer to create this effect.

• **Jet Sideways** creates particles that inherit the producer’s velocity, but channels it into sideways motion. **Extra** adds random motion to the particles. You must animate the Producer to create this effect.

• **Fractal Omni** spreads particles with speed and direction determined by a fractal model. Changes in the fractal model are smoothly interpolated if **Extra Angle** is animated. This type of particle animation is useful for creating any effect where an uneven look is desired such as explosions. **Extra** determines the frequency of the fractal noise used in the animation. **Extra Angle** determines the fractal model used.

• When **Fractal Uni** is chosen, particles erupt from the producer volcanically with speed and direction determined by a fractal model. Changes in the fractal model are smoothly interpolated if **Extra Angle** is animated. This type of particle animation is useful for creating any effect where an uneven look is desired such as explosions. **Extra** sets the frequency of the fractal noise used in the animation. **Extra Angle** sets the fractal model used.

**Velocity** sets the initial speed of the particles as they are emitted from the producer. Once ejected, the speed and direction of the particles is determined largely by **Gravity** and other natural forces. Higher values move the particles faster. Negative values reverse the direction of the particles.

**Birth Rate** sets the number of particles born at a point in time. The higher the Birth Rate, the greater the density of particles. Very high values can increase rendering time.

**Longevity (secs)** sets the life span of the particles. This parameter cannot be animated.

**Gravity** controls the strength of the gravitational force.

**Extra** controls an “extra” factor that adds randomness to the particles motion. The higher the Extra setting, the greater the randomness of the particles motion. The affect varies depending on the **Animation System menu** setting. Some Animation types, such as **Explosive**, do not use Extra.

**Extra Angle** sets an “extra angle” factor. The affect varies depending on the **Animation System menu** setting.

**Max Opacity** sets the highest level of opacity for the particles during their lifetime. Particle’s opacity changes over their lifetime according to the **Opacity Map menu** setting.

The **Opacity Map menu** sets an opacity map for the particles. The selected map, in conjunction with the Max Opacity control, determines the opacity changes for the particles over their lifetime. Choose from the following options.

• **Fade Out** starts the particles at the **Max Opacity** value then fades out the particles.
• **Fade Instructs** the particles transparent then fades in the particles to the **Max Opacity** value.

• **Fade in & out** starts the particles transparent then fades in the particles to the **Max Opacity** value then fades out the particles.

• **Fade out & in** starts the particles at the **Max Opacity** value then fades out the particles then fades the particles back to the **Max Opacity** value.

• When **Oscillate** is chosen, the particles oscillate between Max Opacity and complete transparency.

• **Fade out fast** keeps the particles at Max Opacity until just before the end of their lifetime. Then the particles fade out fast, like sparks going out.

• **Constant** keeps particles at Max Opacity from birth to death.

The **Color Map menu** defines how particle colors are interpolated from the Birth Color to the Death Color value. Choose from the following options.

• **Birth Death** uses the **Birth Color** and **Death Color** values chosen for color transition.

• **Original Death** takes the birth color from the position in the image where the particle originated. The color changes over time into the defined **Death Color**.

• **Birth Original** starts the particle with the defined **Birth Color**. The **Death Color** is taken from the original image where the particle originated.

• **Original Original** takes the color from the original image and retains the color throughout its lifetime.

**Birth Color** determines the color of the particles at birth. This parameter has no affect if the **Color Map menu** is set to **Original Death** or **Original Original**.

**Death Color** determines the color of the particles at death. This parameter has no affect if the **Color Map menu** is set to **Birth Original** or **Original Original**.

The **Particles Objects menu** determines the shape of the particles. Choose from the following options.

• When **Pixel** is chosen, each particle is a single pixel. In motion, the pixels become lines.

• When **Antialiased Pixel** is chosen, the particles are antialiased lines.

• **Star** creates four-pointed stars.

• **Drop** creates particles that are shaped to simulate drops of water.

• **Shaded Sphere** creates spheres, darkened at the edges.

• **Fades Sphere** creates spheres, faded at the edges.

• **Shaded & Faded Sphere** creates spheres, which are both darkened and faded at the edges.

• **Bubble** creates spheres, faded toward their centers to create a bubbly appearance.

• **Motion Polygon** creates polygons. The higher the speed, the larger the particles.
• **3D Polygon** creates 3D polygons, shaded as if the light source is the viewer’s eye. The rotation axis can be set in the Rotation dialog box (accessed by clicking the Options button).

• **3D Squares** creates 3D squares, shaded as if the light source is the viewer’s eye.

• **Cuby** creates particles that are cubes, shaded as if the light source is the viewer’s eye. The rotation speed can be set with Extra Angle.

• **TetraHedrons** creates particles are tetrahedrons, shaded as if the light source is the viewer’s eye.

• **FE** creates particles shaped like the letters, “FE,” shaded as if the light source is the viewer’s eye.

• **Textured Poly** creates particles that are 3D polygons, shaded as if the light source is the viewer’s eye. The polygons take on the texture of the source layer. The rotation speed can be set with Extra Angle.

• **Textured Square** creates 3D squares, shaded as if the light source were the viewer’s eye. The squares take on the texture of the source layer. The rotation speed can be set with Extra Angle.

• **Lens Convex** creates particles shaped like convex lenses.

• **Lens Concave** creates particles shaped like concave lenses.

• **Lens Fade** creates concave lenses fading toward the edges.

• **Lens Darken Fade** creates concave lenses, darkening and fading toward edges.

• **Lens Bubble** creates bubbly lenses, fading inward.

**Particle Birth Size** controls the size of the particles when they first appear.

**Particle Death Size** controls the size of the particles when they disappear.

**Camera Distance** sets the distance from the camera to the center of the Particle World environment.

**After Effects Users:** Camera settings are used only when no After Effects camera is present. If an AE camera is present, the Camera scrubber area is not visible and the camera controls have no affect.

**Camera X Rotation, Camera Y Rotation, and Camera Z Rotation** controls the rotation of the camera on its own X, Y, and Z axes. Adjusting the camera’s X rotation turns it left and right, changing the Y rotation points it up or down, and changing its Z rotation banks the camera left or right.

**Camera Lens Angle** sets the type of “virtual lens” used for processing, similar to the After Effect’s Camera Setting Angle of View. Lowering this value zooms in on the producer (or whatever the camera is facing). Increasing this value creates a wide angle view. The camera automatically adjusts its distance to this value. This may cause a vertigo effect when you animate this parameter.
The **Grid menu** sets which visual guides are displayed. Choose from the following options.

- **Off** does not display any controls.
- **World** displays the particles but turns off the floor and producer.
- **Producer** displays an “X” at the position of the Producer and the associated particles.
- **Producer with particles off** displays an “X” at the position of the Producer without displaying the associated particles.
- **Floor** displays a grid representing the floor of the effect with the associated particles.
- **Floor with particles off** displays a grid representing the floor of the effect without displaying the associated particles.

**Floor** sets the relative height of the floor. See the next section for details.

**Working with the Additional Options**

Clicking the **Options button** provides access to secondary dialog boxes to set a variety of Particle World parameters. These parameters can be saved and reloaded, which makes it easy to create custom settings for specific types of animations. You can save settings, open previous saved settings, or use default settings.

All parameters within the Options dialogs are static. They cannot be animated with key frames.

When you finish adjusting the parameters in one of these secondary dialog boxes, click one of the three buttons at the bottom of the window.

- Click the **Apply button** to apply your changes.
- Click the **Cancel button** to exit without applying your changes.
- Click the **Default button** to return all options to their default values.
Working with the Opacity Map Dialog Box Settings

The Opacity options allows you to modify the opacity levels of your particles at various stages during their lifetime. A graphical display depicts the current opacity map. The left side of the canvas represents the opacity level at birth. The right side represents the opacity level at death. You can drag within this area to customize the opacity map.

Click the dynamic Soften button to subtly soften (or average) the current opacity levels. Press the Soften button to gradually increase the levels of softness. Pressing Soften will automatically apply Normalize when released.

Click the Normalize button to spread the current minimum and maximum values across the entire range of legal values.

Use the Presets menu to choose from a list of available Opacity Map presets.

Working with the Color Map Dialog Box Settings

The Color Map dialog displays a gradient representing the changing colors of your particles over their life span. Clicking one of the small arrows over the gradient opens a standard color picker. By setting different colors, you can create a gradient of up to five colors for your particles to transition through from birth to death. To use this option, you must select the Override checkbox.

Working with the Grid Dialog Box Settings

The Grid Settings dialog gives you control over the reference grid and other visual guides.

Selecting the Horizon checkbox displays a line at the horizon. This can be useful when tilting or rolling the camera. Click the color chip to set the Horizon color.

The Position checkbox displays a marker for the producer. The Producer is at the x atop the line perpendicular to the grid. Click the color chip to change the Position marker color.

The Motionpath checkbox displays a line that shows the Producer's positions throughout the animation. Click the color chip to change the Motionpath color. The Motionpath is not visible until you animate the Producer position.

The Grid checkbox displays the floor (or wall) grid. Click the color chip to set the Grid color.

Draw x Frames determines the number of sample points for the producer motionpath. Higher values increase detail in the motionpath.

Up Axis determines which plane (as seen from X, Y or Z) the grid appears on. This determines the location of the floor plane (but not its physical position).

Divisions set the total number of squares in the grid, while Gridsize sets the scale of the grid.

Selecting the Axis Box checkbox displays a small, reference box in the upper left corner of the source layer that shows the World Axis in the current view.
Working with the Rendering Dialog Box Settings

Click the appropriate Render Particles checkbox to specify which particles to render:

- **Full Render** renders all particles. This is the default option.
- **Above Floor** renders only the particles that exist above the floor.
- **On/Under Floor** renders only the particles that exist on or below the floor.

Click the desired Render Animation checkbox to specify which of the following animation options you want to use:

- **Standard** renders the particles normally. This is the default setting.
- **Reflected on Floor** renders the particles as a reflection on the floor. This is ideal for mirrored surface effects.
- **Projected on Floor** renders the particles as a projection on the floor, calculated from the direction set in the options Light dialog. This is ideal for shadow effects.

Click a Depth Cue checkbox to select from the following choices:

- **Disabled** does not add any depth cueing. This is the default setting.
- When **Fade** is chosen, the particles fade away as they move further from the camera.
- When **Fog** is chosen, the particles change to the fog color as they move away from the camera. Click the color swatch to pick a new fog color.

**Distance** sets the rate at which depth cueing increases. Higher settings increase the Depth Cue affect. Distance is measured in Particle World coordinates (1.0 = source layer width).

Select a **Floor** checkbox to set how the particles react when they strike the floor. The Glue and Bounce option is not available for all Animation types.

- **Ignored** passes the particles through the floor. This is the default setting.
- When **Ice** is chosen, the particles stop falling and slide along the floor.
- When **Glue** is chosen, particles stop moving altogether when they reach the floor.
- When **Bounce** is chosen, the particles bounce when they reach the floor.

**Amount** determines the maximum height of the bounce, **Random** determines the amount of variety in the bouncing particle’s height, and **Spread** sets the amount of variety in the bouncing particle’s direction. The Viscous, Twirl, Twirly, Vortex and Fire Animation System menu setting ignore Bounce and Glue.

The Other Settings section includes the following controls:

- **Delay Particle Release** controls how long (relative to its life span) a particle clings to its birth place, before beginning its assigned motion (based on the Animation System menu setting).
- Select the **Composite with Original checkbox** to composite the source layer within the particle world.
• Select the **Motionblur (Best quality only) checkbox** to always render the particles with motion blur, ignoring any Composition and Layer settings.

**Working with the Settings Dialog Boxes**

Clicking the **Open** or **Save buttons** opens a standard dialog box for loading or saving Option settings. Saving a Particle World preset also saves the Options settings.

• Clicking the **Default button** resets all parameters to their default settings.
• Clicking the **Cancel button** ignores changes and exits the dialog box.
• Clicking the **OK button** accepts changes and exits the dialog box.

**Working with the Gravity Dialog Box Settings**

The Gravity settings specify the direction axis along which gravity pulls the particles. The specified direction is used by the Gravity parameter slider. By default the direction is set to pull particles down the Y axis, which simulates real world gravitational force.

**Working with the Direction Dialog Box Settings**

Use the **Direction** controls to set the main axis on which several Animation Systems are based, for example, Direction Axis and Cone Axis. By default the main axis point upwards. This can be tilted in any direction so that for example a Cone Axis can spray sideways.

**Working with the Light Dialog Box Settings**

Use the **Light** controls to set the position of the directional light source. Light will illuminate particles from the chosen angle. This direction is also used when using Render Option Project on Floor.

**Working with the Rotation Dialog Box Settings**

Use the **Rotation** controls to set the rotation axis for polygon particles. Default rotation axis is equal X, Y and Z rotation. Setting this to Y only would rotate polygon particles only around the Y axis.
**FE Pixel Polly**

*FE Pixel Polly* breaks the source layer into polygons, with or without texture. The effect is similar to a pane of glass shattering and flying apart. You can control the Gravity and Rotation Speed of the shards, as well as the amount of Randomness in Direction and Speed. You can also set the position for the shatter CenterForce (the focal point) of the explosion.

All speed settings take effect from the first frame of the animation. By default, Rotation Speed is set to one revolution per second.

**Unfiltered Image**  
**Filtered Image**

**Scatter Speed** controls the speed at which the shards fly. A negative setting causes the image shards to implode before flying outward.

**Gravity** controls the weight of particles. A higher gravity setting gives the shards more weight causing them to fall more quickly. A negative Gravity setting makes shards rise.

**Rotation Speed** sets how fast the shards spin. At a value of 0, the shards do not rotate.

**Center Force** sets the focal point of the explosion that sends the shards flying, based on X and Y coordinates.

**Direction Randomness** adds randomness to the direction in which the shards fly. Lower settings cause the shards to fly off in a mostly uniform pattern, for example straight out from the point of origin. Higher settings give the explosion greater turbulence, causing the shards to fly in random directions.

**Speed Randomness** lets you control the uniformity of particle speed. Lower settings cause all the shards to fly apart at mostly the same speed. Higher settings cause more variation in the speed of different shards, creating a more chaotic effect.

**Grid Spacing** controls the size of the grid along which images shatter. A larger grid size produces larger shards. A smaller grid size produces smaller shards. Grid Spacing is an initial setting for how you want to split the image. You should not animate this setting.
The **Object menu** sets the type of shard you want. Choose from the following options.

- **Polygon** converts the original image to polygon shapes using the source image color as a color map.
- **Textured Polygon** shapes the shards like polygons that retain the texture of the source image.
- **Square** converts the original image to squares using the source image color as a color map.
- **Textured Square** shapes the shards like squares that retain the texture of the source image.

Select the **Enable Depth Sort checkbox** to create more accurate 3D rendering. Far away shards will not appear in front of closer shards.
**FE Rain**

*FE Rain* creates a scattering of angled streaks that look like falling rain.

![Unfiltered Image](image1) ![Filtered Image](image2)

**Rain Amount** sets the number of rain drops. The number of rain drops selected may not correspond to the number that actually appear in the source layer. (This control has an extended range).

**Rain Speed** sets how fast the rain falls.

**Rain Angle** sets the angle of the falling rain.

**Drop Size** sets the size range of the rain drops.

**Source Depth** lets you control the layering of the rain with the source layer. You can give the appearance of rain being in front or behind the source image. This parameter is most useful if the source layer has an alpha channel containing some transparent areas.

**Opacity** sets the transparency of the raindrops. Setting the slider to a value of 100 provides completely opaque rain drops. At a value of 0, rain drops are completely transparent.
FE Snow

FE Snow creates gently falling snow flakes. You can set the amplitude and frequency of the snow to produce flurries.

Snow Amount determines the amount of snow in the image. The number of snowflakes selected may not correspond to the number that actually appears in the source layer. (This control has an extended range).

Snow Speed controls how fast the snow falls.

Amplitude controls the shape of the snowflakes’ paths as they leave the source point. Use this parameter to add a wobbling effect to the snow. The wobbling causes snowflakes to move from side-to-side, while falling. The higher the value, the more snowflakes move sideways from their original path, at the frequency determined by the Frequency control. At the default value of 0, the flakes follow a straight line. Positive values cause the flakes to follow a sinusoidal (sine wave) path. Negative values cause the flakes to follow a negative sinusoidal path, meaning that the wave dips before it peaks. The amplitude, or height, of the wave increases as the Amplitude value moves away from zero. More extreme Amplitude values produce increasingly erratic flake paths which make the effect appear more chaotic.

Frequency controls the frequency of the wobbling effect in the snow.

Flake Size sets the size range of the snow flakes. Higher the value, the faster snowflakes move from side-to-side, at the amplitude determined by the Amplitude value. (This control has an extended range).

Source Depth controls the layering of the snow with the source layer. You can give the snow the appearance of being in front, or behind, the source layer. This parameter is most useful if the source layer has an alpha channel containing some transparent areas.

Opacity sets the opacity level of the snowflakes. A value of 100 makes all flakes completely opaque, and a value of 0 makes all snow completely transparent (invisible).
FE Star Burst

Use **FE Star Burst** to break an image into stars that spread through space. You can animate this effect to make it appear as if the viewer is flying through a star field.

![Unfiltered Image](image1.png) ![Filtered Image](image2.png)

**Scatter Amount** sets the amount of the scattering. The higher the value, the further the stars scatter away, in all directions, from their original positions. A negative setting scatters stars in the opposite direction from a positive setting. At a value of 0, all objects assume their assigned position within the source layer.

**Speed** sets the rate at which stars travel towards the viewer, like traveling through a star field. A negative value creates the illusion of traveling backwards.

**Phase** aligns the effect to the original position of the layer.

**Grid Spacing** controls how tightly packed the stars are. This also affects the size of the stars.

**Size** works in conjunction with the Grid Spacing parameter to set the size of the stars.

**Blend with Original** blends the original layer without removing the effect result. As the value approaches 0, the original layer fades out.
Chapter 9
Perspective & Time Effects

Introduction ......................................................... 150
FE Advanced 3D ..................................................... 151
FE Cylinder ......................................................... 153
FE Page Turn ....................................................... 155
FE Sphere (w/Reflection Map) ................................. 156
FE Simple Shadow .............................................. 158
FE Time Blend .................................................... 159
FE Time Blend FX ............................................... 160
Introduction

This chapter describes the FE Perspective and Time effects. In the descriptions, sizes and distances are measured in pixels. Some panels provide expansion buttons that toggle to reveal additional controls.
FE Advanced 3D

FE Advanced 3D places the image on a virtual plane and lets you view it from different camera angles. Use lighting to further change the 3D appearance of the image.

Advanced 3D controls provide refined control over image manipulation. FE Advanced 3D also contains a Render Settings dialog box you access by clicking the Options button.

![Unfiltered Image](image1)
![Filtered Image](image2)

**Scrubbers** are indirect manipulation tools that change the settings in one or more of the controls.

- Drag left/right to change **Position X** settings. Drag up/down to change Position Y. Shift-drag to constrain the dimension you first drag.
- Drag up/down to change **Position Z** settings. Drag left/right to change **Position X** settings. Shift-drag to constrain the dimension you first drag.
- Drag the **Rotation** trackball to change the X Rotation, Y Rotation, and Z Rotation settings. Shift-drag to constrain rotation.

**Position X** sets the horizontal position of the image within the layer.

**Position Y** sets the vertical position of the image in the layer.

**Position Z** sets the distance of the image from the camera lens.

**X Rot** rotates the image plane on the horizontal (X) axis.

**Y Rot** rotates the image plane on the vertical (Y) axis.

**Z Rot** rotates the image plane perpendicular to the screen on the Z-axis.

The **Alternative Rotation checkbox** aligns the Advanced 3D space with the space used in the particle systems effects. Select this option to match an Advanced 3D layer with a particle systems layer.
Camera Lens Angle defines the type of virtual lens to use for rendering. As you increase the angle, the foreshortening that creates depth also increases. An angle greater than 90 degrees exaggerates the perspective.

The Render menu lets you choose which faces of the image plane are visible. The choices are Full, Front and Back.

Front view switches to Back view when the camera moves to the other side of the image.

Light Direction sets the light direction with respect to the X, Y plane.

Light Depth sets the light position with respect to the Z axis.

Ambient controls the amount of ambient light. Reduce ambient light to strengthen the depth and texture of the effect.

Diffuse controls the amount of directional lighting on a plane, increasing the 3D appearance.

Specular controls the highlighting on the image plane. Increase the Specular setting to create a bright patch where the light reflects directly on the image.

Roughness controls the spread of the specular highlight. Higher settings make the highlight larger and less intense.

The Show Grid checkbox controls the display of the reference grid. Turn the grid on to use as a reference while working on the 3D orientation of the image plane.
**FE Cylinder**

FE Cylinder wraps the layer image onto a 3D cylinder. You can move a camera around the cylinder in virtual space to view it from any angle. You can also use lighting to change the 3D appearance.

Unfiltered Image  Filtered Image

The Scrubbers are indirect manipulation tools. You drag them to change the settings for one or more of the parameters. To reset a single Scrubber control to its default value, Command-click it (Control-Shift-Click). Standard Shift key constraints are also available. The Control key toggles the available control options.

Drag the Position control to change the position of the cylinder. Drag left/right to change Position X settings. Drag up/down to change Position Y. Shift-drag to constrain the dimension you first drag. Use the + symbol to move on the X and Y axes, and the Z to move along the Z axis.

Drag the Rotation trackball to set the rotation of the cylinder. Shift-drag to constrain rotation.

Radius sets the size of the cylinder.

Position X and Position Y set the position of the cylinder on the X and Y axis respectively.

Position Z sets the distance of the cylinder from the camera lens.

X Rot and Y Rot rotate the cylinder on the horizontal (X) axis and vertical (Y) axis respectively.

Z Rot rotates the cylinder perpendicular to the screen on the Z-axis.

Camera Lens Angle sets the type of virtual lens to use. With a lens angle of 0.0, the cylinder appears flat. As the lens angle increases, the image is foreshortened to create depth and perspective. A setting beyond 90 creates an exaggerated perspective.

The Render menu lets you choose which faces of the cylinder are visible. The choices are Full, Front and Back.
**Light Direction** sets the direction of the light relative to the X and Y surface.

**Light Depth** sets the position of the light relative to the Z axis.

**Ambient** controls the amount of ambient light on the cylinder. Reduce the ambient light to give the cylinder 3D shading.

**Diffuse** controls the amount of direct light that appears on the cylinder. Direct light increases the 3D appearance of the cylinder by allowing shadows to develop on surfaces away from the light source.

**Specular** controls the highlight on the cylinder. Increase the Specular setting to create a bright streak on the cylinder where the light source strikes it directly.

**Roughness** controls the spread of the highlight. A small value creates a small bright highlight. A high value creates a large soft highlight.
FE Page Turn

FE Page Turn peels back the layer to reveal the background. The effect simulates turning the page of a book to reveal the next page.

Fold Edge Position sets the completion percentage for the peel, based on X and Y coordinates. You must keyframe this control to animate the page turn.

Fold Direction sets the direction in which the page folds. To turn a page from the lower right to the upper left, use the default setting of -60 degrees.

Fold Radius controls the shape of the peel. A lower setting creates a sharp folding effect. A higher value creates a more rounded peeling effect.

Light Direction sets the direction that light strikes the backside of the page curl.

Backside let you assign a layer to the back of the peeled page. You can assign the same layer for the backside of the page as for the front. You can also set the layer control to None to specify a color for the back of the page.

Paper Color sets a color for the back of the page. This parameter only applies if you chose None for the Backside.

The Render menu sets which page sides you want to render. The options are Full, Backside and Frontside.

Generally you want settings that peel the page completely off screen. For example, to peel a page from the lower right to the upper left, leave Fold Direction at the default setting of -60 degrees. Then adjust the Fold Edge Position value to the lower right corner, providing you selected the lower right corner of the source layer for the starting point in Fold Edge Position.
FE Sphere (w/Reflection Map)

FE Sphere wraps the layer image onto a sphere. You can rotate the sphere, control lighting, and alter other surface properties.

Unfiltered Image  Filtered Image

Rotation X, Rotation Y, and Rotation Z rotate the sphere on the X, Y, or Z-axis.

Radius controls the size of the sphere with values between 0 and 2. You can also use the dialog box to set values between 0 and 100.

Offset lets you move the sphere within the layer. It also sets the center point of the sphere.

The Render menu sets which face you want to render. Choose from Front & Back, Front Only and Back Only.

Light Direction controls the X and Y position of the light. The light shines on the sphere from the direction shown by the radial control.

Light Depth controls the Z position of the light. A Light Depth of 1 always aims the light directly at the front of the sphere. A Light Depth of 0 lights the sphere from the perimeter. A Light Depth of -1 lights the sphere from the back.

Ambient controls how much ambient (nondirectional) light is reflected on the sphere. This is useful for enhancing detail in areas that are not directly lit. The values for both the slider and dialog box are between 0 and 0.5, with 0.5 creating the most ambient lighting.

Diffuse controls the amount of diffuse (omnidirectional) lighting is reflected on the sphere. More diffusion creates a smoother or haloed light.

Specular sets the highlight intensity of the reflected light. Shiny materials, like chrome, have strong highlights while matte materials, like rubber, have weak highlights. As you increase the Specular value, a specular highlight appears in the center of the diffuse areas where the light reflects directly on the viewer.

Roughness increases the distribution of specular light on the Sphere. This parameter affects the spread of the specular highlight. Higher values make the highlight larger and less shiny. At a lower value, the highlight is small and bright.
Reflective controls the intensity of the reflection map which is set with the Reflection Map menu.

The Reflection Map sets a layer to reflect onto the sphere. For example, you may want the sphere reflect a background layer.

The Enable Internal Shadows checkbox controls the interior sphere shadows. When selected it allows opaque pixels to cast shadows on the interior of the sphere. When deselected it prevents shadows from rendering in the sphere’s interior.

The Enable Transparency Falloff checkbox controls the sphere edges. When this checkbox is selected, the edges of the sphere become more opaque; when this checkbox is deselected, the sphere has a uniform transparency.
FE Simple Shadow

FE Simple Shadow creates a quick and simple three-dimensional effect in two-dimensional space by adding a shadow beneath the selected layer. As a result, the layer appears to float off the surface. The shape of the shadow is determined by the layer Matte.

FE Simple Shadow can be used in a number of ways. For example, you can generate subtle text effects or animate the filter to generate a dramatic free falling object.

![Unfiltered Image](image1) ![Filtered Image](image2)

The FE Simple Shadow is independent of the layer, so you can apply the effect independent of the layer size; no clipping occurs. As a result, you do not need to precompose when working with smaller layers.

Shadow Color specifies the shadow color. A color palette and eyedropper are provided.

Shadow Strength controls the density of the shadow.

Direction controls the direction angle of the shadow. The range is from -360 to 360 degrees.

Distance sets the length of the shadow offset.

Horizontal Bloom controls the blurring of the shadow in the horizontal direction, creating a soft and diffused appearance.

The Link Vertical checkbox controls whether the Vertical value is linked to the Horizontal value.

Vertical Bloom controls the blurring of the shadow in the vertical direction, creating a soft, diffused look.

Blend with Original controls the blending of the shadow with the original image. As the value approaches 0, the original layer fades out, leaving the effect itself.
FE Time Blend

FE Time Blend adds a ghostly trail to the effects of other time-based filters. This works particularly well with particle systems or other movement-oriented animations.

Time Blend is an echo effect which accumulates each rendered frame in a buffer. Any effect applied before Time Blend creates a fading trail. The source should include animation, for example pre-composed scale, position, rotation or a particle system.

Since Time Blend accumulates each rendered frame, you cannot move around the timeline to preview the result. Rendering must be sequential. Since many hosts cache frames to save rendering time, the host application may not pass the Time Blend filter all the required frames, even when rendering sequential. To make sure caching doesn’t scramble the input sequence, you must always manually clear the cache before previewing or final render. To avoid losing the accumulated trail, do not use this filter with effects that dynamically resize the source layer, for example Fast Blur.

For information on clearing the cache, see your host NLE documentation.

This filter is not supported for Apple Final Cut Pro users.

The Buffer Transfer menu determines how the effect buffer is composited with the previous frame.

- **Blend with Original** blends the next frame with the previous frames.
- **Composite under Original** composites the next frame over the previous frames.
- **Composite over Original** composites the next frame under the previous frames.

Buffer Opacity determines the opacity of the pasted frames.
FE Time Blend FX

FE Time Blend FX is a copy and paste filter. You must apply this filter twice to a source layer that includes animated motion. The effect then copies the information from the data buffer and pastes that same information to the next frame.

If you use only one instance with Paste chosen, this filter creates an effect similar to Time Blend. You must combine Time Blend FX with animation since the filter needs to process a parameter, copy the parameter value then paste the values to process again.

Since Time Blend FX accumulates each rendered frame, you cannot move around the timeline to preview the result. Rendering must be sequential. Since many hosts cache frames to save rendering time, the host application may not pass the Time Blend filter all the required frames, even when rendering sequential. To make sure caching doesn't scramble the input sequence, you must always manually clear the cache before previewing or final render. To avoid losing the accumulated trail, do not use this filter with effects that dynamically resize the source layer, for example Fast Blur.

For information on clearing the cache, see your host NLE documentation.

This filter is not supported for Apple Final Cut Pro users.

The Instance menu sets whether to Copy data from the buffer or Paste data to the buffer. The first instance of this filter should be set to Copy to copy the data buffer to the second instance, which should be set to Paste; this pastes the data buffer contents to the next frame.

The Paste Transfer menu sets how the data in the effect buffer combines with the next frame.

- Blend with Original blends the frame with the previous frames.
- Composite under Original composites the next frame over the previous frames.
- Composite over Original composites the next frame under the previous frames.

Paste with Opacity sets the opacity of the pasted frames.
Chapter 10
Stylize Effects

Introduction ......................................................... 162
FE 3D Relief ......................................................... 163
FE Emboss ........................................................... 165
FE Blobbylize (w/Blob Map) .................................... 166
FE Burn Film ........................................................ 167
FE Glass (w/Bump Map) ......................................... 168
FE Glue Gun ......................................................... 170
FE Kaleida ............................................................ 171
FE Mr. Smoothie ................................................... 172
FE RepeTile .......................................................... 173
FE Scatterize ......................................................... 174
FE Fractal ............................................................. 175
FE Glow ............................................................... 176
FE LensStar .......................................................... 178
FE VideoFragment ................................................ 180
Introduction

This chapter describes the FE Stylize effects. Each effect description includes a figure of the effect editor dialog box and a table describing controls.

In the descriptions, sizes and distances are measured in pixels. Some dialog boxes provide expansion buttons that toggle to reveal additional controls.
FE 3D Relief

FE 3D Relief gives an image a three-dimensional look by creating a relief or bump map from the layer RGB, Luminance, or Matte information. Precise color and lighting control is available over the resulting relief surface.

Unfiltered Image  Filtered Image

Bevel Width sets the width of the bevel applied to sharp edges in the image.

The Height From menu sets the channel from which the 3D surface is generated. The choices are Alpha, Luminance, Red, Green, and Blue.

You can provide a relief map in the Alpha without having to use or disturb the color channels.

Scale Height sets the 3D surface height.

Spotlight A Position and Spotlight B Position control the location of a spotlight. Placing this point in the center of the image directs the spotlight in front of the image to cause reflections from flat surfaces. Placing this point away from the center causes the spotlight to shine from that direction.

Color sets the color of the spotlight.
The **Focus/Type menu** sets the type of spotlight view for the relief and determines how the spotlight falls from the center. The choices are: **Hard Edge, Broad, Normal, Narrow, and Laser.**

- **Size** controls the size of the spotlight.
- **Top Color** sets the background color at the top of the image.
- **Left Color** sets the background color to the left of the image.
- **Front Color** sets the illumination perpendicular to the image.
- **Right Color** sets the illumination from the right of the image.
- **Reflections** sets how strongly the five colors and two spotlights illuminate the 3D surface.
- **Blend Original** sets the percent of blending of the original image with the surface reflections.
- **Cut Off Below** sets the threshold value below which the Matte values are zero.
FE Emboss

FE Emboss creates a color embossed image by sharpening and highlighting the edges. Antialiasing is always enabled regardless of the layer quality setting.

Unfiltered Image  Filtered Image

The Channels menu sets the channel or combination of channels to apply the effect. The choices are RGBA, Green, RGB, Blue, Red, and Alpha.

Direction sets the direction of the image edge highlight.

Relief sets the height of the embossed image.

Contrast controls the amplitude of the brightness difference.

Blend With Original blends the embossed image with the original image.
FE Blobbylize (w/Blob Map)

FE Blobbylize (w/ Blob Map) uses the luminance of another input to create a blobby, glossy cutout of the other image. The Blob Layer can be virtually anything, from simple text to a complex particle animation.

This effect is a dual-input effect. The second input should be the clip that you want to use as a stencil to create your blobby cutout. The luminance of this input layer determines the stencil created.

To create a blobbylized image with as much detail as possible, make this second input luminance of the input as sharp as possible.

Smoothness sets the roundness of the effect.

Light Source sets the position of the light source. The light gives depth to the blobs produced by the effect.

Ambient controls the amount of ambient light used in the effect.

Diffuse controls the amount of diffused light that the effect uses.

Specular controls the highlighting on the blobs.

Roughness controls the spread of the highlighting. A low setting creates a small, bright highlight. A high setting creates a large, soft highlight.

The Boost Depth checkbox adds extra details to the source image.
FE Burn Film

FE Burn Film creates the illusion of film burning or melting. You control the amount, central location, and randomness of the effect. To animate this effect, you must set at least two keyframes in the Burnt control with different settings.

Burnt sets the amount of burning or melting to use. Set keyframes to start the burn at zero, then proceed to total consumption.

Center specifies the center point of the burn or melt. Place the center point anywhere on the source image.

Random Seed sets a random value for the burn pattern generation.
FE Glass (w/Bump Map)

**FE Glass** creates a convincing glass-like appearance. To accomplish this effect, the selected image defines a bump map, which is then used to create a glossy, 3D texture.

Use FE Glass to create dramatic and innovative effects by using values from a different layer to create the illusion of that layer rising through the source layer.

FE Glass (w/Bump Map) is a dual-input effect, where the second input specifies the bump map. For a single input version of this effect, the clip to which the effect is being applied is used for the bump map.

The **Light Type menu** sets the type of light to use.
- **Distant Light** appears like the sun shining down on the images at a particular angle.
- **Point Light** appears like a light bulb hanging over the image at a set location, but radiating light in all directions.

**Light Position** controls the position from which the light originates.

**Light Angle** sets the angle of the Distant Light.

**Light Height** sets the distance of the Point Light from the layer.

**Ambient** controls the amount of ambient light in the effect.

**Diffuse** sets the brightness of the area of the image directly illuminated by the light source.

**Specular** controls the highlights on the surface.

**Roughness** controls the spread of the highlight. A low setting creates a small bright highlight. A high setting creates a large soft highlight.
The **Base Bump On menu** lets you select which data set of the selected Bump Map layer for the Glass effect to use as the basis of the bump. The choices include: Red, Green, Blue, Alpha, Luminance, and Lightness.

**Bump Height** sets the relative height of the bump effect. Use the slider or click the current value to change the setting.

**Displacement Influence** controls the amount of displacement relative to the Bump Height. **Softness** controls the smoothness of the features in the glass.
FE Glue Gun

FE Glue Gun is a painting effect that uses blobby particles to create the illusion of writing or drawing with a glue gun. You can accomplish painting or writing by manually setting keyframes and moving the brush position.

After Effects users can use the Motion Sketch keyframe assistant to brush their lines onto the source image.

Brush Position determines the position of the brush at any given point in time. Combining changes in brush position with proper use of keyframes can create a very convincing illusion of brushing or writing.

Stroke Width sets the size of the glue line.

Density controls the height of the glue.

Time Span sets the life span of the brush stroke. Setting this to 0 makes the glue permanent.

Reflection Amount sets how much the glue reflects the source image.

Blob Influence controls the viscosity, or blobbiness, of the paint.

The Paint Action menu sets the glue type.

- Plain creates a static, toothpaste type glue.
- Wobbly creates a liquid, constantly changing glue.

Wobble Width and Height set the size/shape of the glue nozzle.

Wobble Speed controls the speed of the wobbling effect.
FE Kaleida

**FE Kaleida** creates a kaleidoscopic effect on the layer. The kaleidoscope image becomes a tile that is repeated across the layer.

![Unfiltered Image](image1) ![Filtered Image](image2)

**Set Center** sets the center point for the tile used in the Kaleidoscope.

**Size** sets the tile size. The objects inside the image do not become larger or smaller when you change size setting. Only the tiles themselves change size. Larger tiles contain a greater portion of the image.

The **Kaleida Type menu** lets you choose the type of kaleidoscopic effect you want. The choices are: **Unfold, Fish Head, Can Meas, Flip Flop, Flower, Dia Cross, Flipper, and Starfish.**

**Rotation** changes the angle of the image in the kaleidoscope

The **Floating Center checkbox** marks the center of the effect. When deselected, the center of the kaleidoscopic effect is centered to the layer.
**FE Mr. Smoothie**

FE Mr. Smoothie transforms images into flowing, psychedelic patterns. You can use it to create background textures or wild special effects.

![Unfiltered Image](image1) ![Filtered Image](image2)

The **Flow Layer** lets you choose which layer to apply the effect.

The **Use menu** allows you to choose the data for flow control from the selected Flow Layer. The choices include: Red, Green, Blue, Alpha, Luminance, Lightness, Hue, and Saturation.

**Smoothness** controls the fluidity of the color patterns. Low smoothness reveals the basic shapes of the Flow Layer. Increasing smoothness takes the image farther from its origins.

**Sample A** and **Sample B** identify the color in the image used to produce the effect. A gradient between the two colors is mapped in a pattern according to the Flow Layer control and other settings.

**Revolve** changes the gradient phase (with respect to the mapping). As you change the Revolve setting, different colors from the gradient appear in different regions of the image.

**Color Loop** lets you choose the direction of the gradation (AB or BA) and lets you increase the flow density with two mirroring options (ABA and BAB).
FE RepeTile

FE RepeTile uses its layer image as a tile, which it can repeat horizontally and vertically in any of several patterns. It has a blending function that can make almost any tile appear seamless.

Expand Right and Left set the right and left extents of the effect in terms of layer pixels. If the layer image is 100 pixels wide, setting Expand Right to 300 repeats the tile three times to the right.

Expand Down and Up set the down and up extents of the effect in terms of layer pixels.

The Tile Type menu sets the rule for repeating the image. The choices are: Repeat, Checker Flip H, Checker Flip V, Unfold, Checker 180°, Checker Flip 45°, Checker 90° CW, Checker 90° CCW, Rosette, Random, and None.

Blend Tile Borders mixes a range of pixels where tiles abut to hide the edge. Increasing this setting spreads the area where pixels are mixed.
FE Scatterize

**FE Scatterize** creates an exploding or dispersing effect by scattering the pixels in your image. For example, you might make your logo scatter into a cloud of dust or have a cloud of dust collect into your logo.

![Unfiltered Image](image1.png) ![Filtered Image](image2.png)

**Amount** controls the degree of scattering. A negative setting scatters pixels in the opposite direction from a positive setting.

**Right Twist, Left Twist** give the particles a left or right twisting motion. You can also twist them both ways simultaneously. The particles twist around a horizontal axis.
FE Fractal

FE Fractal replaces the layer on which it is applied and generates a fractal image.

The Type menu sets the type of fractal. The choices are Mandelbrot, Julia 4, Mandelbrot 4, Barnsley J1 and Julia Lambda.

Center sets the location around which the effect is to be applied.

Zoom % zooms in or out of the image.

Aspect Ratio (W:H) changes the aspect ratio around a point from width to height.

The Seed A menu changes the default real seed value for the pattern generation. A Seed is an initial number from which a series of random numbers are generated.

The Seed B menu changes the default imaginary seed value for the pattern generation.

Detail controls the number of iterations of the fractal calculation and, therefore, the amount of detail. As you zoom in, you may need to increase this number. Ranges from 1 to 256 iterations.

Color Palette changes color tone of pattern. The choices are Wild, Grayscale, Earth, Silver, Cool Spectrum, Clouds, Prism and ICE.

Rotate Palette ranges from 0 to 255 relative levels of colors. This parameter changes the assignment of colors to features in the fractal image by rotating the image palette selected in Color Palette. The fractal image contains 256 colors.
**FE Glow**

*FE Glow* takes the brighter parts of an image and their surrounding pixels and brightens them for a hazy diffused look.

![Unfiltered Image](image1) ![Filtered Image](image2)

The *Glow Based On* menu specifies whether the effect uses the bright part of the color channels or the solid part of the Matte.

- **Alpha Channel** bases the glow position on the matte edge information. This choice is useful for titles or masks.
- **Color Channels** bases the glow on the color of the image/text.

**Glow Threshold** specifies that the glow effect is to be applied to pixels with brightness values higher than this threshold value.

**Glow Radius** specifies the linear distance of the glow effect. A large radius value causes a more diffuse glow effect. A small radius value causes a smaller glow region.

**Glow Intensity** sets the brightness of the glow, which increases as this value increases.

The Composite Glow menu controls where the glow affects the image. The glow can be on top of the image, behind the image, or the glow can be used without the original. The choices are *On Top*, *Behind*, and *None*.

The *Glow Operation* menu controls how the glow is composited with the original image. *Normal, XOR Lighter, Add, Darker, Subtract, Min, Multiply, Max, Difference, Screen, And, Overlay*, and *Or, Hard Light* are the choices.

The *Glow Colors* menu controls the colors used in the glow. This can be the color of the original image, or it can be derived from the provided Color A and Color B.

- **Original Colors** bases the glow on colors in the original video and any previous effects.
- **A & B Colors** lets you choose via two color palettes.
The **Color Looping menu** determines how many times the AB color alternates within the glow radius. When you base the glow on AB, the lower parameters define the order in which they emerge from the glow source. This effect is more visible on larger radius glows.

The choices are **Sawtooth A→B, Sawtooth B→A, Triangle A→B→A, and Triangle B→A→B.**

The triangle choices are a little smoother than the Sawtooth choices.

**Color Loops** defines how many times the color loop is repeated within the glow. When the Color Loops value increases, more alternations between color A and color B are used.

**Color Phase** sets the phase, or starting point, of the color looping. Only use this control when the Glow Colors menu is set to *A & B Colors*.

**A&B Midpoint** sets the relative balance of colors A and B.

**Color A, Color B** defines a range of colors to be used for the glow. A color palette and eyedropper are provided.
FE LensStar

**FE LensStar** selects the highlights of an image and produces stars at those locations. You control which parts of the image generate stars by selecting a color. This can create the illusion of very bright light sources in the highlights. Selecting a predominant color in an image (for example, selecting blue in a seascape scene) or applying extreme tolerance settings results in many stars and longer render times.

![Unfiltered Image](image1) ![Filtered Image](image2)

Stars that result from this effect have the following characteristics:

- Stars have four arms, which are approximately one pixel wide.
- Stars are generated by individual pixels in the input image.
- All stars have the same length and the same rotation angle.
- Star color is taken from, or influenced by, the color of the pixel that generates it.
- Compositing is used to place the stars on the input image.
- Stars have their own transparency information, independent of the original image, to facilitate compositing on other layers.
- Stars fade from center to the ends of the arms, so the stars blend as they fade.

**Color to Match** places stars on image pixels with colors that closely match the Color to Match color. A color palette and eyedropper are provided.

**Match Tolerance** controls how closely pixels must match the color to place stars. As the value increases, it is easier for a pixels color to match, resulting in more stars.

**Match Type** requires that matching pixels match more closely than the eight neighboring pixels when the **Hard Match checkbox** is selected. Use this option to limit the number of stars in areas where many pixels match.

**Star Length** specifies the length of the arm of the star extending from the center of the star.

**Star Angle** specifies the angle of the star arm.
Star Brightness specifies the strength, or brightness, of the star. A value of 100 causes the center of the star to have the color specified for the star.

Star Color optionally specifies the star color. A color palette and eyedropper are provided.

Colorize specifies the percent of the Star Color that replaces the image color. The higher the value, the more the Star Color replaces the image color.

Rainbow controls the fraction of rainbow colors to use when drawing stars. These rainbow colors blend with the star color determined by the Colorize slider.

Rainbow Loops specifies the rate at which the rainbow colors change along the star arm.

Rainbow Phase sets the starting rainbow color at the star center. This is most useful when animated, causing the colors to travel down the star arms.

Blend Original sets the fraction of the input image to used on output. When set to 0, the result should be a Matte of stars.
**FE VideoFragment**

**FE VideoFragment** gives an image the appearance of fragmentation by making a number of copies of the frame and displacing them from the original by a radius. The copy positions are equally spaced around a circle of this radius length.

Copies sets the number of copies of the image to repeat.

When the Include Original checkbox is selected, the original image is included in the resulting FE image.

Radius specifies the radial distance by which copies of the image are displayed.

Angle Specifies the angle of the displacement of the first copy. Subsequent copies are displaced around a circle after that first placement.
Chapter 11
Working with Transitions Effects

Introduction ................................................................. 183
FE Glass Wipe ............................................................ 183
FE Grid Wipe ............................................................ 184
FE Image Wipe (w/Gradient) ........................................ 185
FE Jaws ................................................................. 186
FE Light Wipe .......................................................... 187
FE Radial Scale Wipe ................................................ 188
FE Scale Wipe .......................................................... 189
FE Twister (w/Backside) ............................................. 190
**Introduction**

This chapter describes the FE Transitions effects. Each effect description includes a figure of the effect editor dialog box and a table describing controls.

In the descriptions, sizes and distances are measured in pixels. Some dialog boxes provide expansion buttons that toggle to reveal additional controls.
FE Glass Wipe

FE Glass Wipe creates a glossy transition by using the displacement and light values of either the source or destination image. The result is a glassy upper layer melting away to reveal the layer beneath.

Layer to Reveal sets the layer that you want to reveal.

Gradient Layer sets the layer that you want to use as a displacement map for the FE Glass Wipe effect.

Transition Completion sets the completion percentage of the transition. Key frame this control to set the start and end of the transition.

Displacement Amount sets the height of 3D texture in the glass. The higher the displacement, the more virtual high and low areas seem to appear as the FE Glass Wipe effect occurs.

Softness sets the smoothness of the feature in the glass.
FE Grid Wipe

FE Grid Wipe creates a transition that cuts the source image into squares and wipes it off the screen. The wipe starts from the center point and moves evenly out toward the edge of the source image.

Unfiltered Image  Filtered Image

Transition Complete specifies the completion percentage of the transition. Key frame this control to set the Start and End point of the transition.

Center sets the center point for the transition and hub of any specified rotation.

Rotation sets the rotation of the effect. With this effect the entire grid rotates, not its individual elements.

Border sets the width of the transition border.

Tiles sets the total number of tiles in the grid.

The Transition Type menu sets the transition type.

- Doors splits the source image into two parts.
- Radial wipes in a radial shape.
- Rectangle wipes in a rectangular shape.

Reverse Transition reverses the direction of the wipe.
Working with Transitions Effects

FE Image Wipe (w/Gradient)

FE Image Wipe (w/Gradient) uses a layer to create a transition based upon a supplied gradient.

Completion defines the completion percentage of the transition. Keyframe this parameter to set the start and end points of the transition.

Border Softness softens the edges of the transition.

Gradient Softness controls the softness of the selected gradient.

Gradient sets which layer to apply the effect.

The Base Gradient Upon menu specifies the data set of the gradient to use for controlling the wipe. The choices are Red, Luminance, Green, Lightness, Blue, Hue, Alpha, and Saturation.

Inverse Gradient reverses the colors of the gradient.
FE Jaws

FE Jaws creates a transition that splits the source image into two parts, with each part having a tooth shaped border along the splitting edge.

Transition describes the completion percentage of the transition. Keyframe this control to set the start and end of the transition.

Transition Center sets the center point for the transition and hub of any specified rotation.

Direction controls the angle at which the jaws open.

Height and Width determine the height and width of the teeth. You can change the size and number of teeth.

The Transition Type menu lets you choose the tooth shape.

- **Spikes** creates triangular teeth for a shark-like bite.
- **Robo Jaw** creates trapezoidal teeth for a mechanical bite.
- **Block** creates rectangular teeth for a block-like bite.
**FE Light Wipe**

**FE Light Wipe** creates a transition that uses a light source to wipe away the source layer. This light can either be a solid color or can be sampled from the source image as it is being wiped.

![Unfiltered Image](image1) ![Filtered Image](image2)

**Transition Completion** describes the completion percentage of the transition. Keyframe this control to set the start and end of the transition.

**Center** sets the center point for the transition.

**Direction** sets the angle of the light during the transition. Keyframe this control to create a rotating shape for your light.

**Intensity** determines the brightness of the light.

**Color** sets a color for the light. A color palette and eyedropper are provided.

**Color from Source** samples colors from the source image during the transition.

The **Transition Type menu** sets the shape for your light source.

- **Doors** splits the source image into two parts with a wall of light wiping each part off the screen.
- **Radial** creates a circle of light that grows or shrinks to wipe the source image off the screen.
- **Rectangular** creates a rectangle of light that grows or shrinks to wipe the source image off the screen.

**Reverse Transition** reverses the direction of the transition effect.
FE Radial Scale Wipe

FE Radial Scale Wipe is a radial wipe where the edges fold around a central circle.

Transition Center identifies the center of the transition.

Transition Completion describes the completion percentage of the transition. Keyframe this control to set the start and end of the transition.

When the Reverse Transition checkbox is selected, the wipe begins at the periphery and moves toward the center. When the checkbox is deselected, the wipe begins from the center and moves outward.
**FE Scale Wipe**

FE Scale Wipe stretches a layer on or off the screen by scaling a portion of the image.

*Unfiltered Image*  *Filtered Image*

**Scale Amount** sets the scaling factor.

**Scale Center** identifies the center point where the scaling effect begins.

**Direction** sets the angle in which the image scales.
FE Twister (w/Backside)

FE Twister twists away one image to reveal another. By animating the FE Twister offset, you can twist the sources into a layer that appears to be the back of the source. FE Twister with Backside is a dual-input effect.

Unfiltered Image  Filtered Image

Backside inputs the destination clip into the current image to twist.

If you use FE Twister as a single-input effect and set Backside to Self, the destination image is the same as the source image. The image appears to twist into itself and then squirt back out again. If you select None as your destination, the image twists into oblivion.

Completion defines the completion percentage of the transition. Keyframe this control to set a start and end point for the transition.

Shading adds a dimensional lighting effect to the layer.

Center sets the location of the twist vortex.

Axis sets the angle of the twist.
Index

A
Add Edits
  using to create transitions 24
After Effects 12
  applying BCC filters 12
  applying BCC filters as transitions in 12
  understanding contextual controls 14
  working with BCC point controls 14
Alpha Map
  dialog box 109
Animating parameters
  After Effects
    menus 14
Applying filters
  in After Effects 12
  in Final Cut Pro 20
  in Premiere Pro 15

B
Blur 32
Boris FX 28
Boris RED 28
Brightness and Contrast 46

C
Channel Blur 33
Chroma channels (I and Q) 34
Chroma/Luma Blur 34
chrominance color space 34
Color Balance (HLS) 47
Color Balance (RGB) 48
Color controls
  in After Effects 14
  in Final Cut Pro 27
  in Premiere Pro 19
Color Offset 49
Contextual Controls
  in After Effects 14
in Final Cut Pro 28
in Premiere Pro 19
creating a mask 50
Cross Dissolves
  using to create transitions in Final Cut Pro 22
Custom dialog box 77

D
Directional Blur 35

F
FE
  Spot Light (w/Gel Layer) 125
FE 3D Relief 178
FE Advanced 3D 166
FE Alpha Map 109
FE Ball Action 136
FE Bend It 65
FE Bender 66
FE Blobblyze (w/Blob Map) 181
FE Blur 32
FE Blur and Sharpen effects 31
FE Brightness and Contrast 46
FE Bubbles 138
FE Bulge 62
FE Burn Film 182
FE Channel Blur 33
FE Channel Noise 108
FE Chroma/Luma Blur 34
FE Color Balance (HLS) 47
FE Color Balance (RGB) 48
FE Color Correction effects 45
FE Composite 110
FE Cylinder 168
FE Directional Blur 35
FE Distort effects 61
FE Drizzle 139
FE Emboss 180
FE EZ LazyWaves 63
FE EZ Ripples 64
FE Flo Motion 67
FE Fractal 190
FE Gamma-Pedestal-Gain 53
FE Glass (w/Bump Map) 183
FE Glass Wipe 197
FE Glow 191
FE Glue Gun 185
FE Grid Wipe 198
FE Griddler 68
FE Hair 140
FE Hair (w/Hairfall Map) 140
FE Image Wipe (w/Gradient) 199
FE Invert 54
FE Jaws 200
FE Kaleida 186
FE Lens 69
FE LensStar 193
FE Levels 55
FE Light Burst 2.5 122
FE Light effects 121
FE Light Sweep 124
FE Light Wipe 201
FE LightBlast 127
FE LightTornado 129
FE LightWhirl 131
FE Median 114
FE MinMax 115
FE Mr. Mercury 142
FE Mr. Smoothie 187
FE Noise 116
FE Page Turn 170
FE Particle effects 135
FE Particle Systems II 145
FE Particle World 149
FE Pixel Polly 158
FE Power Pin 70
FE Radial Scale Wipe 202
FE RepeTile 188
FE Replace Color 57
FE Ripple Pulse 71
FE Scale Wipe 203
FE Scatterize 189
FE Sharpen 38
FE Simple Shadow 173
FE Simple Wire Removal 112
FE Slant 72
FE Slant Matte 73
FE Smear 74
FE Snow 161
FE Soften 39
FE Sphere 171
FE Spherize 75
FE Spin Blur 40
FE Spiral Blur 41
FE Split 76
FE Split2 77
FE Spot Light 125
FE Star Burst 162
FE Stylize effects 177
FE Threshold 50
FE Threshold RGB 51, 52
FE Tiler 78
FE Time Blend 174
FE Time Blend FX 175
FE Tint 59
FE Toner 52
FE Twirl 79
FE Twister 204
FE Unsharpen Mask 42
FE VideoFragment 195
FE WaterWaves 80
FE Zoom Blur 43
Filters
applying as transitions 24
applying in After Effects 12
applying in Final Cut Pro 20
Final Cut Pro 20
applying effects as generators 20
applying effects as transitions 20, 24
applying filters 20
creating BCC transitions by overlapping clips 24
creating BCC transitions using cross dissolves 22
rendering effects in RGB 26
understanding Contextual Controls 28
user interface 26
Final Effects Complete 12, 20, 28

G
Gain 53
Gamma 53
Gamma-Pedestal-Gain 53
Generators
applying in Final Cut Pro 20
Group headers
in After Effects 12
in Final Cut Pro 26
in Premiere Pro 18

I
ICE’d FE
Color Offset 49
Vector Blur 36
Vector Blur (w/Vector Map) 36
Icons, meaning of 4
In Phase Chrominance channel (I) 34

L
Layer controls in Final Cut Pro 26
Layer menus
After Effects 13
Premiere Pro 18
Luminance channel (Y) 34
Luminance color space 34

P
Parameter groups
in After Effects 13, 18
in Final Cut Pro 26
in Premiere Pro 18
Pedestal 53
Plug-ins, understanding 3
Point controls
Final Cut Pro 27
in After Effects 14
in Premiere Pro 19

Precomposing
Layer menus 13, 18
Premiere Pro
applying BCC filters as transitions 15
applying filters 15
BCC user interface in 15
Color controls 19
enabling direct manipulation 17
tips for using BCC filters in 17
understanding contextual controls 19

R
Replace Color 57

S
Sharpen 38
Soften 39
Spin Blur 40
Spiral Blur 41

T
Threshold 50
Timeline
applying effects as transitions 24
Transitions
creating with the Razor Blade tool 24

U
Unsharpen Mask 42
User interface
After Effects
color controls 14
group headers 12
Layer menus 13
point controls 14
Final Cut Pro
color controls 27
group headers 27
layer controls 26
point controls 27
Premiere Pro 15
color controls 19
group headers 18
Layer menus 18
point controls 19

V
Vector Blur 36
Vector Blur (w/Vector Map) 36

W
working with parameter groups 12

Z
Zoom Blur 43